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Executive Summary 
The U.S. Department of Transportation (USDOT) and the Federal Aviation Administration (FAA) 
announced the establishment of the Unmanned Aerial System (UAS) Integrated Pilot Program (IPP) in 
November, 2017. The IPP allows selected groups to participate in demonstrating methods of safely and 
efficiently using UAS vehicles in the National Airspace System (NAS). As part of the IPP, the Lead 
Participants (LP) for each selected group were asked to support noise measurements of their Unmanned 
Aerial Vehicles (UAV). This report is the first in an intended series of reports on the noise characteristic 
of the UAVs in the IPP, with one report for each of the IPPs. 
 
A requirement to measure and report UAV noise levels was included in the IPP agreements due to 
potential concerns with noise from UAS operations in close proximity to communities. UAVs may 
operate much closer to people than conventional aircraft, leading to new concerns about their 
operations. In addition, UAV may have unusual and unique noise characteristics compared to manned 
aircraft. Finally, UAVs under 55 pounds are currently exempt from the noise certification requirements 
of manned aircraft when the UAV is operated under U.S. Code of Federal Regulation (CFR) Title 14, Part 
107. UAV which operate outside this regulation currently must meet the noise requirements of CFR Title 
14 Part 36. The FAA intends to use the data collected from the IPP noise measurements to determine 
the applicability of Part 36 to UAS operations, and possibly modify those requirements if the data 
support that decision. 
 
The measurements were conducted by the USDOT’s Volpe National Transportation Systems Center 
(Volpe). Volpe was selected to perform these measurement due to their experience with aircraft noise 
measurements and aircraft noise certification.  
 
The FAA selected the Choctaw Nation of Oklahoma’s (CNO) IPP group as the first participant for noise 
measurements due to a number of factors. The CNO has a test site which is conducive to noise testing 
due its low ambient noise and total control over access to the site. The CNO IPP operates a wide variety 
of UAS. The CNO has successfully demonstrated their ability to meet a number of objectives in their IPP 
agreement with the FAA.  
 
The acoustic measurements took place at the CNO’s Daisy Ranch near Daisy, Oklahoma on July 15th and 
July 16th, 2019. Four UAVs were measured: three multicopters ranging from 5 to 45 pounds and a fixed-
wing vehicle with a wing span of about 7 feet. Measurements were conducted in a manner consistent 
with the existing noise certification requirements for light helicopters and small propeller-driven 
airplanes. Measurements were also taken with the vehicles operating on simulated missions unique to 
UAS capabilities. Over 100 unique events were captured on the four UAVs. 
 
The initial results of the acoustic measurements are included in this report. Additional reports may 
include more detailed analyses of the recorded data as more data are collected in future measurement 
programs. 
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1 Introduction 
This report is the first of an intended series. This series will present basic noise data and information 
regarding noise measurements performed by the USDOT’s Volpe Center (Volpe) in support of the 
Federal Aviation Administration’s Office of Environment & Energy. These measurements support the 
FAA’s National Airspace UAS Integration Pilot Program (IPP). The purpose of the IPP is to facilitate and 
expedite the integration of UAS into the National Airspace (NAS) in a safe and effective manner. 
 
One of the primary concerns regarding such integration is the issue of community noise, and how UAS 
may impact the public in daily operations. Before UAS are included in the NAS, the FAA needs to 
determine what, if any, limitations or requirements (e.g. certification) should be placed on UAS 
operations regarding noise. The FAA is seeking data to determine an appropriate way forward; this 
measurement program directly supports that goal. 
 
This report documents the noise measurements performed at the Choctaw Nation of Oklahoma’s (CNO) 
IPP site near Daisy, Oklahoma during July 2019, and provides information about the site, the Lead 
Participant’s (LP) organization, agreed IPP mission, and typical operations of specific UAS, including 
measured noise levels during those typical operations.  In addition to the provided noise levels, 
continuous, calibrated, full-bandwidth audio recordings were made during these operations.  
 
The audio recordings from this measurement campaign, including those from other IPP measurement 
programs, and potentially from additional sources, could be used for further analysis and evaluation to 
aid FAA in determining appropriate specifications, procedures, metrics, and limits for noise certification 
of such aircraft. 
 
In addition to the information in the body of the report, Appendix A provides information on Volpe’s 
UAS noise measurement instrumentation specifications and setup procedures, which is common to all 
IPP LP sites. Appendix B presents the questionnaires sent to IPP lead participants regarding details of the 
measurement site and the aircraft to be tested, prior to the start of the measurement program.  
Appendix C provides instructions for setup and operation of Volpe’s small, on-aircraft GPS tracking 
system. Appendix D provides the reader with information about individual aircraft events; these 
individual events are the basis for the data provided in the body of the report.  
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2  Noise Measurements of UAs at the 
Choctaw Nation of Oklahoma’s IPP site 

 

2.1 CNO IPP Information  

2.1.1 Mission description 

The IPP Mission for CNO focuses on agricultural, public safety, and infrastructure inspections. The CNO 
plans to conduct both Beyond Visual Line of Sight (BVLOS) operations over people and nighttime 
operations.  

2.1.2 Partners 

CNO is partnering in the IPP with the following organizations; this partnership includes operating the 
aircraft measured in this report and developing operational procedures for those aircraft: 
 

- Noble Research Institute, Ardmore, Oklahoma: independent non-profit agricultural research 
organization, operators of a DJI M200 UAV 

- University of Oklahoma, Norman, Oklahoma: public university, joint operators with CNO of a 
Yuneec Typhoon 

- Oklahoma State University, Stillwater, Oklahoma: public university, operators of a Skywalker X-8 
and Gryphon Dynamics GD28X. 

2.1.3 Site description 

The CNO IPP site is located on the CNO’s Daisy Ranch, near Daisy, Oklahoma. The ranch covers over 
44,000 acres. The IPP site is in the southwestern area of the ranch. The following sub-sections describe 
particular aspects of the IPP site. 

2.1.3.1 Terrain 

The terrain in the ranch is a mixture of mountains, prairie, and forest. The IPP site is in grassland 
primarily used for raising cattle. Figure 1 shows an overview of the area in the IPP used in this acoustic 
test; the figure uses the standard map convention of ‘up’ representing north. The site was mowed so 
that the microphones were located in a circularly mowed section of about 40 feet diameter. A north-
south line was mowed to provide the UAV operators with a clear visual reference for the desired flight 
path over the microphones. A base station area – the yellow canopy in the figures – located about 80 
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feet to the east of the centerline microphone was used as the location of the acoustic measurement 
equipment and as the staging area for vehicle preparation. A detail of the site is provided in Figure 2, 
including the positions of the three microphones used in this measurement program. The centerline 
ground plane microphone was placed at the center of the mowed circle. A centerline pole-mounted 
microphone – with the microphone 4 feet from the ground – was placed 10 feet south of the centerline 
ground plane microphone.  A second ground plane microphone was placed 20 feet to the west of the 
north-south centerline. The two ground plane microphones were installed in a manner consistent with 
the requirements of CFR Title 14, Part 36, Appendix G (U.S. Federal Government, 2019), the small 
propeller-driven airplane noise certification requirements document for the United States. The pole-
mounted microphone was installed in a manner consistent with the requirements of Part 36, Appendix J 
(U.S. Federal Governement, 2019), the U.S. light helicopter noise certification requirements document. 
Note that as of this report, Appendices G and J are the only aircraft noise certification standards that 
might be considered to be applicable for noise certification of sUAS in the United States. More details of 
the acoustic data collection system are provided in Section 2.2.1 and in Appendix A. 
 
In Figure 2, the white object between the sideline ground plane microphone (“Offset Grnd Mic” in the 
figure’s legend) and the Hover/Landing Point (the “pad”) is the Skywalker X-8 vehicle. The 
Hover/Landing point is the location where all multicopter operations started and ended. The X-8 vehicle 
was launched from the south of the measurement site using a bungee system. 
 
Figure 3 shows the initial mowing of the test site, before the microphone and supporting equipment 
were put in place. Figure 3 was shot from the position of the base station, looking west at the 
measurement site.  
 
Figure 4 shows a detail of one of the ground plane microphone installations. The microphone is 
suspended inverted over the ground plate with the prescribed Appendix G spacing between the plate 
and the microphone diaphragm. The microphone is offset from the ground plate center and the ground 
plate is faired in the surrounding surface to minimize the effects on the acoustic measurements of 
changing the surface impedance. The red line on the surface plate indicates the direction of the vehicle 
passes over the plate (north-south). 
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Figure 1, Overhead view of acoustic measurement site 

 

 
Figure 2, Close-up of measurement site – with annotation 
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Figure 3, Preparing the measurement site by mowing 
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Figure 4, Detail of ground plane microphone installation 
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2.1.3.2 Weather 

The weather during the measurements was generally dry and sunny. 2019’s Hurricane Barry came 
ashore in the Southeastern United States in the days prior to the start of the measurement program; an 
increase in cloudy weather occurred, but there was no precipitation during the measurement period. 
 
Winds were generally light in the morning, but strengthened during the day. Winds were strongest on 
the measurement day of 17 July. Local meteorological data (temperature, relative humidity, and wind 
speed and direction) were captured at a 2Hz sample rate (twice per second) during the entire 
measurement period for each aircraft pass-by event using a portable ultrasonic sensor. Wind data are 
included in Appendix D. 

2.1.3.3 Ambient sound 

Wind noise was the dominant ambient sound.  For some aircraft flybys and for some microphones, the 
ambient noise levels were sufficiently high to prevent capture of the full 10 dBA rise and fall required for 
a valid Sound Exposure Level (SEL) measurement.  The SEL data tables in Appendix D include information 
on the quality of the SEL measurements for each applicable event.   
 
The measurement site is in the middle of an active cattle ranch. While no cattle came near the 
microphones, on the morning of July 16th, a cattle feeding operation took place in the vicinity of the 
measurements, see Figure 5 and Figure 6. During this period, the ambient noise of the cattle precluded 
the collection of UAV noise data. When the feeding operation concluded, the cattle noise diminished 
and the measurements continued. 
 
The measurement site is in the vicinity of the McAlester Army Ammunition Plant. The plant detonates 
ammunition on a daily basis at known periods during the day. Explosions from the plant can be heard at 
the measurement site. However, since the time of the planned explosions are known, the acoustic 
measurements were suspended during this period. 
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Figure 5, Cattle near measurement site at start of the feeding operation 

 
  

 
Figure 6, Cowboys near measurement site looking for stray cattle 
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2.1.4 UAVs operated by CNO 

The Yuneec Typhoon is operated by CNO and the University of Oklahoma as part of the IPP. 

2.1.4.1 Yuneec Typhoon 

The Yuneec Typhon is an electrically powered hexcopter (six rotors) with a maximum takeoff weight 
(MTOW) of about 5.3 pounds. The largest dimension (rotor tip to rotor tip) is about 20.5 inches. The 
Typhoon was operated with its camera and gimbal removed and the Volpe START tracking system 
installed. Figure 7 shows an example of a Typhoon.  
 
The Typhoon was flown on the morning on July 16, 2019. A summary of the results from the sound level 
meters (SLM) used in the measurement program are given in Table 1 through Table 12 in Section 3.2.  
 

 
Figure 7, Yuneec Typhoon 

2.1.5 UAVs operated by CNO partners 

 
The DJI M200 is operated by the Noble Research Institute as part of the IPP.  The Gryphon Dynamics 
GD28X and the Skywalker X-8 vehicles are operated by OSU. Each vehicle is discussed in the following 
sub-sections.  
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2.1.5.1 DJI M200 

The DJI M200 is an electrically powered quadcopter (four rotors) with a MTOW of about 13.5 pounds 
and the tip-to-tip length of about 35 inches. The M200 was flown with its camera and gimbal still 
attached. Figure 8 shows an example of an M200. 
 
The M200 was flown in the afternoon on July 16, 2019. A summary of the results from the SLMs used in 
the measurement program are given in Table 13 through Table 24 in Section 3.3.  
 
 
 
 

 
Figure 8, DJI M200 

 
 

2.1.5.2 Gryphon Dynamics GD28X 

The GD28X, shown in Figure 9, was the heaviest vehicle participating in the measurement program. The 
GD28X is an electrically powered octocopter (eight rotors) which can be flown at an MTOW of 70 
pounds, but for this test was limited to 45 pounds to comply with the FAA’s Part 107 rules. The GD28X is 
over 4 and a half feet from rotor tip to rotor tip.  Figure 10 shows the GD28X while the Volpe START 
system is being installed. Note that the GD28X is intended to be operated as a camera platform, but, like 
the Typhoon, had its camera and gimbal removed for this measurement program. 
 
The GD28X was flown on the morning of July 17, 2019. A summary of the results from the SLMs used in 
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the measurement program are given in Table 25 through Table 35 in Section 3.4.  
 
 

 
Figure 9, Gryphon Dynamics GD28X 

 

 
Figure 10, Installing START tracking equipment on the GD28X 

 

2.1.5.3 Skywalker X-8 

The Skywalker X-8 is a flying wing vehicle powered by a single pusher propeller driven by an electric 
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motor. The X-8 has a maximum takeoff weight (MTOW) of about 6.6 pounds. The largest dimension 
(wing tip to wing tip) is about 7 feet.  The X-8 was modified by OSU to include a forward-looking camera, 
but the camera was removed for this acoustic test and the Volpe START tracking system installed. Figure 
11 shows an example of an X-8. This image doesn’t convey the size of the aircraft; Figure 12 shows the 
vehicle prior to launch, with the vehicle’s operators in the image for scale. The vehicle is launched with a 
bungee cord; the pusher propeller is designed with folding blades to reduce the possibility of damage to 
the propeller or motor during landings, as well as to the operator, during hand launches. In Figure 12, 
the propeller can be seen hanging with both blades folded back.  
 
The GD28X was flown on the afternoon of July 17, 2019. A summary of the results from the SLMs used in 
the measurement program are given in Table 36 through Table 41 in Section 3.5.  
 

 
Figure 11, Skywalker X-8 
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Figure 12, Preparing the X-8 for launch 

 

2.2 Noise measurement procedures and instrumentation 

This section provides an overview of the processes and equipment used in the CNO measurement 
program. A detailed description can be found in Appendix A. 

2.2.1 Acoustic data collection system 

As mentioned earlier in the report, the primary data collection system included three microphone 
positions. Each microphone position used a GRAS Model 40AO 1/2 inch pressure microphone. 

2.2.1.1 Microphone locations  

The centerline ground plane microphone was used as the local origin of coordinates. This microphone 
and its installation in the measurement area complied with the requirements of Part 36, Appendix G.  
 
Also on the centerline of the flight paths was a pole-mounted microphone. This microphone was located 
10 feet south of the primary ground plane microphone. This microphone was in compliance with Part 
36, Appendix J. 
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The secondary ground plane microphone was located 20 feet to the west of the primary ground plane 
microphone. This microphone was included for research purposes. This microphone was set up as an 
Appendix G microphone, but its position offset from the flight path was not in compliance with 
certification requirements. 

2.2.1.2 Sound Level Meters 

For each of the three microphones, the acoustic signal was fed into a Larson-Davis 831 Type 1/Class 1 
SLM capturing 0.5 second time histories of the slow response, A-weighted noise levels. These SLMs were 
the primary instruments used to provide the data presented in Section 3. 

2.2.1.3 Digital Audio Recordings 

In addition to the noise level data recorded by the SLMs, the audio data were also input to a Sound 
Devices 744T digital audio recorder. The signal from each microphone was split prior to the input of the 
SLM, with one signal path directly feeding the SLM, and the other signal path going through a gain-
conditioning amplifier (in this case, a secondary SLM, used only to control signal gain), then input to the 
744T. The 744T was set at a 48 kHz sample rate with 24-bit Analog to Digital Conversion. 
 
A time synchronization signal from a dedicated GPS timecode receiver was also input to the 744T.  

2.2.2 Vehicle tracking system 

Due primarily to their smaller size and lower weight, sUAS are quieter than conventional aircraft, and 
therefore must fly closer to the microphones than specified in the Noise Certification rules to enable an 
adequate signal-to-noise ratio. However, the closer the vehicles fly to the microphones, the more the 
uncertainty in their position can influence the quality of the measured acoustic data. This topic is 
discussed in detail in a prior Volpe report (Senzig, Marsan, & Downs, UAS noise certification and 
measurement status report, 2017). To enable accurate tracking of the sUAS, the Volpe Center developed 
the START (Survey and Tracking Apparatus for Research in Transportation) system.  
 
The START system is a lightweight (typically 1 lb. or less, varying with specific configuration) GNSS-based 
system that is capable of providing higher fidelity position information than a typical GPS system. The 
START system does this by retaining the raw satellite data from the GNSS system and storing those data 
for post-processing. This post-processing can improve position accuracy by accounting for atmospheric 
variations that can affect the GPS signal paths and which can’t be known at the time of the 
measurements. Post-processing can yield accuracies on the order of 5 to 10 centimeters. 
 
The START system uses a rover and a base system. The base station did not move during the period of 
the tests, while the rover was attached to each of the flight vehicles for their flight sequence. The rover 
is a compact system based on a PC-on-a-stick, GPS antenna, battery, and supporting cabling. The START 
system is discussed in detail in Appendix C. 
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2.2.3 Meteorological data collection system 

Meteorological data were also collected during the noise test. A Vaisala WXT-520 weather station 
supplied wind speed and direction, temperature, and relative humidity information directly into the 
primary microphone’s SLM for concurrent recording of noise and meteorological data. The collection of 
wind, temperature, and relative humidity data was conducted in a manner compliant with CFR Title 14, 
Part 36, Appendices G and J.  

2.3 Flight procedures 

This section provides an overview of the flight procedures used in the CNO measurements. These 
procedures were intended to capture typical operations expected during actual use in the NAS. These 
uses were identified during discussions with CNO staff during the scoping visit to the IPP site on June 
27th, 2019.  
 
Both the multicopters and the fixed-wing aircraft flew a common set of level overflights at both slow 
and fast speeds. The low speed operations were intended to replicate a loitering operation where the 
vehicle is operated with the intension of conserving energy to the extent possible. The fast overflight 
operations were a dash at the maximum speed of the vehicle. These level overflights all took place at a 
height of 150 feet over the microphones. These slow and fast overflights were intended to be minimum 
and maximum power operations over the microphone to bracket any possible power settings.  
 
The slow and fast overflights were done in alternating north-to-south then south-to-north passes. 
Between each pass, the vehicle was set into a loitering operation while the IPP measurement team 
determined the acceptability of the pass.  Where possible, each type of operation was repeated until at 
least three acceptable passes had been measured. 
 
In addition to these common operations, operations unique to the particular class of vehicle were also 
conducted. These are discussed in the following sub-sections. 

2.3.1 Multicopter Flight Procedures 

This section discusses the flight procedures used by the multicopter vehicles: the Typhoon, the M200, 
and the GD28X.  

2.3.1.1 Vertical takeoff and landing operations 

The vehicle operators flew each of the three multicopters through a series of simulated vertical takeoff 
and landings.  The takeoffs originated at the Hover/Landing point shown in Figure 2 above. The 
operators flew the vehicles to an altitude of 150 feet with a vertical ascent, then proceeded due north 
far enough from the measurement sight that the vehicle was visible, but not readily audible. After 
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loitering for enough time for the measurement team to determine the acceptability of the event, the 
vehicle was flown back to the measurement site, again at 150 feet AGL, and then vertically descended to 
the landing/hover point. The pair of operations (takeoff and landing) were repeated at least three times 
for each vehicle. Not-to-scale schematics of the takeoff and landing operations are shown in Figure 13 
and Figure 14, respectively. Note that measurements and recordings captured the full duration of the 
takeoff and landing events, including motor start and spin-up for takeoffs, and spin-down for landings. 
This is in contrast to conventional noise certification takeoff or approach event requirements, where 
such events are simulated. 
 
These takeoff and landing operating are intended to mimic potential operations in a community where 
landing and takeoff operations might be required, e.g. with package delivery systems. 
 

 
Figure 13, Schematic of vertical takeoff operation 
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Figure 14, Schematic of vertical landing operation 

 

2.3.1.2 Hover operations 

Each of the multicopters were flown in hover operations at 4 feet AGL over the hover/Landing point. 
The hovers were conducted with the aircraft facing each of the four cardinal compass directions: the 
vehicles typically started with a hover facing north; this direction was held for 30 seconds, then the 
vehicle was rotated (i.e. yawed) 90 degrees and again held in that position for 30 seconds. The rotation 
was repeated two more times. The rotations on the yaw axis were done to determine the effects of 
wind on the noise of the vehicle in hover; researchers have noted that multicopters exhibit unsteady 
noise during hover (Cabell, McSwain, & Grosveld, 2016). The variation in noise may be related to the 
wind contributing to unsteady loading on the rotors, with the wind direction contributing relatively 
more to the fluctuation on the advancing blade than the retreating blade. 
 
Where time and battery power permitted, some multicopters were also operated in hover, facing a 
single direction at multiple altitudes over the microphones. For these operations, the vehicles were held 
facing north, and vertically ascended over the hover/landing point at increments of 50 feet. At each 50 
foot increment, the vehicle was hovered in place for 30 seconds.  

2.3.1.3 Infrastructure inspection operations 

Each of the multicopters was also operated for several series of simulated infrastructure inspection 
operations. For these operations, the vehicle was initially flown to a distance of at least 500 feet to the 
north of the hover/landing point at an altitude of 100 feet AGL. The vehicle was then flown back to the 
measurement area. Once over the hover/landing point, the vehicle was descended to 80 feet AGL, then 
held in a hover at that altitude for 30 seconds. At the end of the 30 seconds, the vehicle performed a 
vertical climb back to 100 feet AGL and then departed the measurement area at that altitude to the 
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northern loiter area. A not-to-scale schematic of this type of operation is shown in Figure 15. 
 
The Infrastructure inspection operation was intended to simulate an inspection process on a vertical 
structure such as a building, bridge, or an electrical power line tower. 

 
Figure 15, Schematic of infrastructure operation 

2.3.2 Fixed-wing Flight Procedures 

In addition to the common level flyovers, the fixed-wing X-8 was also tested on a series of simulated full-
power takeoffs (T/O) targeted for 100’ AGL at the microphones. Unlike the level flyovers which 
alternated direction, the simulated takeoffs all occurred as passes from north to south. In addition to 
launching into the prevailing wind, this enabled the vehicle operators to better estimate the point at 
which full power and a takeoff pitch change had to occur to bring the vehicle over the microphone near 
the target height of 100 feet.  
 

2.3.3 General Philosophy Relating to Flight Procedures 

For typical noise certification flight-testing, strict limits are provided for deviations from the target flight 
performance, including elements such as:  

• Aircraft position deviation relative to target flight path; 
• Aircraft speed and power deviation 
• Rotor or propeller rotational speed deviation. 
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Experience has suggested that difficulties in maintaining performance within such limits can lead to a 
situation where the pilot is attempting frequent, sometimes extreme, course corrections that are not 
typical during conventional flight. Pilot fatigue and the learning curve required to attain the target 
accuracy can reduce the number of usable passes captured during a measurement period. It is also 
noted that for automated or automation-assisted flight operation, it may be impossible to prevent such 
corrections that may be initiated by the autopilot or piloting assists.  
 
For these reasons, and in the interest of obtaining as much data as possible for research purposes, the 
CNO remote pilots were advised to operate the test aircraft in a normal manner. The priority for each 
operation was to attain stabilized flight conditions when near the microphone area, rather than 
achieving target performance or position accuracy.    
 
This philosophy assumes that off-specification flights can provide useful data. This approach to 
measurements is dependent on the availability of high-precision position information. For this 
measurement program, such high-precision position information was provided by Volpe’s START 
position tracking system.  
 
One of the outcomes of such a measurement philosophy is that there is likely to be a wider variation in 
noise levels from flight to flight, which may require precise position information to be corrected or 
adjusted to more nominal flight paths. A quick look at the statistical data in Appendix D accompanying 
the measured results in this report suggests that the variation is not unreasonably greater than might be 
expected for such small off- the-shelf aircraft. 
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3 Noise Levels of UAS Measured at CNO 
IPP site 

 

3.1 Noise Metric Definitions 

The instrumentation used for noise measurement was configured to capture noise level data for 
selected metrics in the field. These data are presented in Section 3 and in Appendix D. The metric 
definitions and their associated nomenclature as used in this report are provided below. Metric 
calculations, equations, and detailed descriptions can be found in ASA/ANSI S1.1 (Acoustical Society of 
America, American National Standards Institute, 2013). 
 

• LASmx (Maximum slow time-averaged A-weighted sound level, abbreviation: “LAMax”) 
• LAE (A-weighted sound exposure level, abbreviation: “SEL”) 
• LAeq (A-weighted equivalent sound level, abbreviation “LEQ”) 

 
Noise metrics are referenced by their formal names in all tables and charts, and are referred to by their 
abbreviations in the report text. 
 

3.2 Noise Measurement data for Typhoon 

The data in the following tables represent the arithmetic averages for all passes in a particular series. 
Data for individual passes are provided in Appendix D. Note that the normalized distance tables do not 
include a normalized SEL. Issues with normalizing SEL measurements are discussed in a prior Volpe 
document (Senzig, Marsan, Cutler, & Read, 2018). 
 

3.2.1 Typhoon Slow Flyover measurements summary 

Table 1. Typhoon series 100 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE 
dB notes 

100 7 
Slow 
LFO 
150’ 

CLG 57.9 68.6 Slow flight, level flyover at 150 
foot nominal height above the 

microphones 
CLP 54.7 67.0 
SLG 58.1 68.6 
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Table 2. Typhoon series 100 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

100 7 
Slow 
LFO 
400’ 

CLG 49.7 Slow flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 46.2 
SLG 50.0 

3.2.2 Typhoon Fast Flyover measurements summary 

Table 3. Typhoon series 200 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

200 4 
Fast 
LFO 
150’ 

CLG 58.9 66.1 Fast flight, level flyover at 150 foot 
nominal height above the 

microphones 
CLP 55.1 65.8 
SLG 58.8 66.2 

 

 
Table 4. Typhoon series 200 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

200 4 
Fast 
LFO 
400’ 

CLG 50.1 Fast flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 46.4 
SLG 50.1 

 
 

3.2.3 Typhoon vertical takeoff measurements summary 

Table 5. Typhoon series 300 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff  
CLG 67.4 Takeoff from pad near microphones, 

vertical ascent to 100 feet, depart 
area to North 

CLP 60.0 
SLG 63.5 

 
 
Table 6. Typhoon series 300 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff 
CLG 54.1 

Takeoff normalized to 100 foot 
distance CLP 49.9 

SLG 54.0 
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3.2.4  Typhoon vertical landing measurements summary 

Table 7. Typhoon series 301 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

301 4 Landing  
CLG 72.7 Arrive from North at 100 foot cruise, 

vertical descent to landing pad, 
motors to idle or off 

CLP 65.5 
SLG 70.1 

 
 
Table 8. Typhoon series 301 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

301 4 Landing 
CLG 61.1 

Landing normalized to 100 foot 
distance CLP 57.3 

SLG 62.2 
 

3.2.5 Typhoon Infrastructure Inspection measurements summary 

Table 9. Typhoon series 400 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

400 4 Inspect.  

CLG 63.1 
Infrastructure Inspection simulation. 
Arrive from north in 100 foot cruise; 
stop over pad; vertical descent to 80 

feet AGL; hold position for 30 
seconds, vertical ascent to 100 feet, 

depart area to North 

CLP 59.6 

SLG 63.1 

 
 
Table 10. Typhoon series 400 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

400 4 Inspect. 
CLG 62.5 

Infrastructure Inspection normalized 
to 100 foot distance CLP 58.6 

SLG 62.6 
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3.2.6 Typhoon Hover measurements summary 

Table 11. Typhoon series 500 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LAeq dB 

- North 
LAeq dB 
- East 

LAeq dB 
- South 

LAeq dB 
- West notes 

500 2 Hover  
CLG 58.9 56.7 55.9 56.9 

See 
Below CLP 58.8 56.5 56.1 57.5 

SLG 57.3 55.8 55.4 55.8 
Hover Notes: Hover over pad, 4 foot AGL; align with cardinal compass points and hold for approximately 
30 seconds. The actual averaging times for the events are given in Appendix D. 
 
Table 12. Typhoon series 500 noise levels average normalized to 100 feet; A-weighted 

Series Passes Event 
Type Mic LAeq dB 

- North 
LAeq dB 
- East 

LAeq dB 
- South 

LAeq dB 
- West notes 

500 2 Hover  
CLG 45.8 43.9 42.9 43.9 Scaled 

to 100 
feet 

CLP 48.8 46.9 46.4 47.9 
SLG 47.2 45.6 45.0 45.8 

3.3 Noise Measurement data for M200 

3.3.1 M200 Slow Flyover measurements summary 

Table 13. M200 series 100 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

100 4 
Slow 
LFO 
150’ 

CLG 58.8 67.6 Slow flight, level flyover at 150 
foot nominal height above the 

microphones 
CLP 54.7 65.2 
SLG 59.0 67.9 

 
 
Table 14. M200 series 100 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

100 4 
Slow 
LFO 
400’ 

CLG 51.8 Slow flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 47.5 
SLG 51.9 
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3.3.2 M200 Fast Flyover measurements summary 

Table 15. M200 series 200 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

200 4 
Fast 
LFO 
150’ 

CLG 59.3 65.9 Fast flight, level flyover at 150 foot 
nominal height above the 

microphones 
CLP 55.7 62.9 
SLG 59.5 66.1 

 
 
Table 16. M200 series 200 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

200 4 
Fast 
LFO 
400’ 

CLG 52.1 Fast flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 48.2 
SLG 52.3 

 

3.3.3 M200 vertical takeoff measurements summary 

Table 17. M200 series 300 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff  
CLG 67.1 Takeoff from pad near microphones, 

vertical ascent to 100 feet, depart 
area to North 

CLP 60.0 
SLG 64.9 

 
 
Table 18. M200 series 300 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff 
CLG 57.1 

Takeoff normalized to 100 foot 
distance CLP 51.9 

SLG 57.7 
 

3.3.4 M200 vertical landing measurements summary 

Table 19. M200 series 301 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

301 4 Landing  
CLG 74.5 Arrive from North at 100 foot cruise, 

vertical descent to landing pad, 
motors to idle or off 

CLP 67.1 
SLG 72.0 
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Table 20. M200 series 301 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

301 4 Landing 
CLG 64.9 

Landing normalized to 100 foot 
distance CLP 59.3 

SLG 64.2 
 

3.3.5 M200 Infrastructure Inspection measurements summary 

Table 21. M200 series 400 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

400 3 Inspect.  

CLG 66.1 
Infrastructure Inspection simulation. 
Arrive from north in 100 foot cruise; 
stop over pad; vertical descent to 80 

feet AGL; hold position for 30 
seconds, vertical ascent to 100 feet, 

depart area to North 

CLP 61.9 

SLG 65.8 

 
 
Table 22. M200 series 400 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

400 3 Inspect. 
CLG 66.2 

Infrastructure Inspection normalized 
to 100 foot distance CLP 62.0 

SLG 66.1 
 

3.3.6 M200 Hover measurements summary 

Table 23. M200 series 500 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LAeq dB 

- North 
LAeq dB 
- East 

LAeq dB 
- South 

LAeq dB 
- West notes 

500 2 Hover  
CLG 66.2 68.4 67.6 68.6 

See 
Below CLP 57.9 59.6 59.2 59.7 

SLG 60.5 60.7 61.1 61.6 
Hover Notes: Hover over pad, 4 foot AGL; align with cardinal compass points and hold for 30 seconds 
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Table 24. M200 series 500 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LAeq dB 

- North 
LAeq dB 
- East 

LAeq dB 
- South 

LAeq dB 
- West notes 

500 2 Hover  
CLG 52.7 54.7 54.0 55.0 Scaled 

to 100 
feet 

CLP 47.6 49.2 49.0 49.3 

SLG 50.5 50.6 51.1 51.6 
 
 

3.4 Noise Measurement data for GD28X 

3.4.1 GD28X Slow Flyover measurements summary 

Table 25. GD28X series 100 noise average levels as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

100 8 
Slow 
LFO 
150’ 

CLG 70.5 79.2 Slow flight, level flyover at 150 
foot nominal height above the 

microphones 
CLP 66.4 75.4 
SLG 70.9 79.7 

Note the different number of runs in the as-measured and the normalized data. A tracking system 
failure in four of the runs prevented the calculation of accurate distances, so only the four passes with 
acceptable distance calculations were used in the normalization. 
 
Table 26. GD28X series 100 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

100 4 
Slow 
LFO 
400’ 

CLG 62.0 Slow flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 57.9 
SLG 62.3 

 

3.4.2 GD28X Fast Flyover measurements summary 

Table 27. GD28X series 200 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

200 5 
Fast 
LFO 
150’ 

CLG 73.2 80.0 Fast flight, level flyover at 150 foot 
nominal height above the 

microphones 
CLP 69.1 76.2 
SLG 73.4 80.2 
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Table 28. GD28X series 200 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

200 4 
Fast 
LFO 
400’ 

CLG 64.0 Fast flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 59.9 
SLG 64.1 

 

3.4.3 GD28X Vertical takeoff measurements summary 

Table 29. GD28X series 300 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff  
CLG 80.4 Takeoff from pad near microphones, 

vertical ascent to 100 feet, depart 
area to North 

CLP 73.2 
SLG 80.5 

 
 
Table 30. GD28X series 300 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff 
CLG 69.7 

Takeoff normalized to 100 foot 
distance CLP 67.5 

SLG 71.9 

3.4.4 GD28X vertical landing measurements summary 

Table 31. GD28X series 301 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

301 4 Landing  
CLG 79.7 Arrive from North at 100 foot cruise, 

vertical descent to landing pad, 
motors to idle or off 

CLP 72.8 
SLG 81.9 

 
 
Table 32. GD28X series 301 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

301 4 Landing 
CLG 67.8 

Landing normalized to 100 foot 
distance CLP 66.0 

SLG 69.6 
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3.4.5 GD28X Infrastructure Inspection measurements summary 

Table 33. GD28X series 400 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

400 4 Inspect.  

CLG 77.6 
Infrastructure Inspection simulation. 
Arrive from north in 100 foot cruise; 
stop over pad; vertical descent to 80 

feet AGL; hold position for 30 
seconds, vertical ascent to 100 feet, 

depart area to North 

CLP 73.7 

SLG 77.7 

 
 
Table 34. GD28X series 400 noise levels average normalized to 100 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

400 1 Inspect. 
CLG 74.7 

Infrastructure Inspection normalized 
to 100 foot distance CLP 70.0 

SLG 75.0 
 

3.4.6 GD28X Hover measurements summary 

Note that during the testing for the GD28X hover operations, the signal from the pole microphone was 
lost. Also, a problem with the Volpe START system during the hover tests led to no tracking data 
availability for determining the normalization data. 
Table 35. GD28X series 500 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LAeq dB 

- North 
LAeq dB 
- East 

LAeq dB 
- South 

LAeq dB 
- West notes 

500 2 Hover  
CLG 77.3 77.6 77.4 77.3 

See 
Below CLP - - - - 

SLG 76.4 76.0 75.3 74.3 
Hover Notes: Hover over pad, 4 foot AGL; align with cardinal compass points and hold for 30 seconds 
 

  



        CNO IPP Noise Measurements    30 

3.5 Noise Measurement data for X-8 

3.5.1 X-8 Slow Flyover measurements summary 

Table 36. X-8 series 100 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

100 8 
Slow 
LFO 
150’ 

CLG 53.2 61.4 Slow flight, level flyover at 150 
foot nominal height above the 
microphones, see note below 

CLP 51.1 62.4 
SLG 53.6 61.3 

Note that for this series, the Centerline Pole microphone did not measure an LASmx 10 dB above the 
ambient for any of the eight passes.   
 
Table 37. X-8 series 100 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

100 8 
Slow 
LFO 
400’ 

CLG 44.0 Slow flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 43.3 
SLG 44.4 

 

3.5.2 X-8 Fast Flyover measurements summary 

Table 38. X-8 series 200 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB 
LAE  
dB notes 

200 8 
Fast 
LFO 
150’ 

CLG 61.6 67.9 Fast flight, level flyover at 150 foot 
nominal height above the 

microphones 
CLP 58.8 65.9 
SLG 61.3 67.7 

 
 
Table 39. X-8 series 200 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

200 8 
Fast 
LFO 
400’ 

CLG 53.2 Fast flight, level flyover 
normalized to 400 foot height 

above the microphones 
CLP 53.7 
SLG 54.3 
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3.5.3 X-8 Takeoff measurements summary 

 
Table 40. X-8 series 300 noise levels average as measured; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB LAE  dB notes 

300 4 Takeoff  
CLG 60.4 66.1 

Simulated Appendix G takeoff, approach to 
microphones from the north CLP 58.2 64.6 

SLG 61.1 67 
 
 
Table 41. X-8 series 300 noise levels average normalized to 400 feet CPA; A-weighted 

Series Passes Event 
Type Mic LASmx 

dB notes 

300 4 Takeoff 
CLG 52.7 

Takeoff normalized to 400 foot 
distance CLP 52.1 

SLG 54.7 
 

3.6 Comparison with other UAS noise data 

Table 42 provides a rough comparison of noise level data from the current measurement campaign as 
well as data collected from previous sUAS noise measurements in which Volpe has participated and data 
collected from other programs. The noise levels in this table have been normalized (by applying a simple 
distance adjustment) to a common 400 foot distance for a number of vehicles. The two leftmost 
columns indicate the name and type of vehicle. The third column shows the weight of the vehicle in 
pounds. The fourth column indicates the operation type conducted during the particular noise test. 
“Takeoff” indicates that an operation similar to Part 36 Appendix G test was used. “Level overflight” 
indicates a straight-and-level pass over the microphone (only fast overflights are included); The fifth 
column indicates the type of microphone installation: “IGPM” is an Inverted Ground Plane Microphone, 
which is the type of installation explicitly specified in CFR Title 14, Part 36, Appendix G, and, for the CNO 
data, represents the average of the two ground plane microphones used in the test; “MOP” indicates a 
simpler ground plane installation, with the microphone and preamplifier body placed horizontally on a 
plate. The penultimate column represents the A-weighted maximum noise level normalized to a 
distance of 400 feet. The rightmost column provides an indication of measurement quality, where “Cert” 
indicates that the data were used in actual noise certification testing,  “Cert Quality” indicates that the 
instrumentation performance characteristics and the measurement and testing procedures of CFR Title 
14, Part 36, Appendix G or Appendix J were followed – with minor exceptions – in the test, and 
“Research” indicates that the data may be useful for research purposes, but were not collected with the 
same rigor as for noise certification. 
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Table 42. Comparison of UAS noise test data 

Vehicle Vehicle 
type 

Weight 
(lb) Operation Microphone 

type 
LASmx @ 

400' 
Data 

quality 
AeroVironment 

PUMA Fixed wing 13.4 Takeoff IGPM 37.9 Cert 

Insitu Scan Eagle Fixed wing 46.0 Takeoff IGPM 58.1 Cert 
Navmar 

TigerShark Fixed wing 397 Takeoff IGPM 90.8 Cert 
Quality 

Skywalker X-8 Fixed wing 6.6 Takeoff IGPM 53.7 Cert 
Quality 

Navmar 
TigerShark Fixed wing 397 Level overflight IGPM 88.2 Cert 

Quality 

Skywalker X-8 Fixed wing 6.6 Level – fast IGPM 53.8 Cert 
Quality 

Edge 540 scale 
model Fixed wing 25 Level overflight MOP 53.4 Research 

DJI Phantom 2 Quadcopter 3.5 Level overflight MOP 44.9 Research 

DJI M200 Quadcopter 13.5 Level - fast IGPM 52.2 Cert 
Quality 

Prioria Hex Hexcopter 5.5 Level overflight MOP 45.9 Research 

Yuneec Typhoon Hexcopter 5.3 Level - fast IGPM 50.1 Cert 
Quality 

GD28X Octocopter 45.0 Level - fast IGPM 64.1 Cert 
Quality 

Data with bold font indicate vehicles from the CNO measurement program 
 
  

Figure 16 illustrates the noise level vs. weight trend for fixed-wing vehicles. Note that the aircraft 
represented in this Figure were measured according to the Part 36, Appendix G standard.  

Figure 17 illustrates the trend for rotary-wing vehicles during level overflight.  Note that the LAMax 
noise metric presented for these aircraft in Table 42 and Figure 17 is not the time-integrated SEL metric 
that is required for Appendix J noise certification. Also, unlike Figure 16, this figure includes noise levels 
from research quality measurements.  
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Figure 16, UAS noise comparison - fixed-wing takeoff 

 

 
Figure 17, UAS noise Comparison - rotary-wing flyover 
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4 Conclusions and Next Steps  

4.1 Observations 

We note that in general, the LAMax levels for rotorcraft do not vary significantly between slow and fast 
flight. However, the X-8 fixed wing aircraft was significantly quieter in slow flight.  
 
Within the multicopter group of vehicles, the GD28X (the heaviest UAV), was louder than the smaller 
two.  The difference in noise levels for the Typhoon and the M200 (the smaller two multicopters) also 
followed the general trend of the heavier vehicle being slightly louder. 

4.2 Lessons Learned 

While the measurement program generally went without incident, a number of issues arose that could 
be improved. 

4.2.1 START system installation 

The START aircraft position tracking system appeared to be sensitive to Electro-Magnetic Interference 
(EMI) broadcast from the vehicles’ own electronics, and was also impacted by overheating when 
mounted in certain configurations. Numerous mounting solutions for the START system were attempted 
for some vehicles before a final configuration was found, which allowed both the START system and the 
vehicle itself to operate correctly.  
 
A method of mapping the EMI from the START system and of determining the EMI from the vehicle in 
the field should be found. EMI from the START system should be mitigated to the extent possible, 
however that mitigation must be within the weight constraints of the vehicle MTOWs.  
 
START system mounting configurations should avoid the positioning of components (especially the CPU 
and battery) in such a way that exposes them to constant, direct sunlight. This configuration should be 
especially avoided if the mounting locations on the aircraft are particularly dark, and therefore heat 
absorbent. 
 
Since returning from this measurement program, the team has identified and obtained detectors 
suitable for use in the field to aid in identifying such problems. 
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4.2.2 Flight log files 

The flight log files used in the CNO measurement program were based on log files successfully used in 
manned aircraft measurements. Those flight logs were adequate for those flight operations which 
closely resembled manned aircraft operations, but did not work well for UAS operations which did not 
have a close correspondence with manned flight. In particular, the logs were not satisfactory when 
working with the hover operations.  Revised logs will be used for future measurement programs to 
enable easier field documentation during these events. 

4.3 Next Steps 

4.3.1 Additional measurements 

Similar noise measurements are planned for other sites, aircraft and participants in the IPP, as well as 
measurements though other venues, of other unconventional aircraft, including small and large UAVs, 
air-taxis, eVTOL aircraft, etc. The intention is to develop a meaningful database that will enable the 
identification of important noise characteristics across existing and potential aircraft that will or may 
operate in the NAS. 

4.3.2 Data analysis 

Any data analysis in this report has intentionally been kept to a minimum, and should be considered to 
be preliminary in nature. The authors anticipate that one or more follow-on reports featuring various 
analyses in more detail will be generated, perhaps after the end of the IPP program, when measurement 
data for other aircraft are available and more information is known about UAS operations in the NAS. 

4.3.3 Modifications to the process 

A determination should be made if the microphone position and number used in this measurement 
program are adequate for future IPP measurements. 
 
A determination should also be made if the flight procedures are adequate, or if they need modification. 

4.3.4 Potential analysis methods 

Analysis methods for the final report are not yet known. While this report includes the traditional LAMax 
and SEL metrics common to aircraft noise measurements, additional metrics which may provide insight 
into human response to UAS noise may be included. In addition to metrics, narrowband acoustic 
analyses may also provide insight.  
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4.3.5 Modeling and simulation data 

FAA and Volpe will need to consider how to model new and proposed UAS operations, similar to the 
current requirements for modeling manned aircraft operations.  
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Appendix A: Acoustic Instrumentation  

A.1 Instrumentation 

Figure 18 shows a schematic component and signal flow layout of the acoustical instrumentation used 
for UAS IPP noise testing. 

 

Figure 18, Schematic of acoustic equipment 
  
The individual components of the system are discussed in detail below.  
 
GRAS 40 AO microphones 
The GRAS 40 AO microphone has a frequency range from 3.15 Hz to 20 kHz. It requires no external 
polarization voltage. This microphone is not as sensitive as other microphones used by the Volpe center, 
but it has a predominantly flat, extended upper frequency response. This ability to capture higher 
frequencies than microphones normally used for conventional aircraft measurement was considered 
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important due to the potential close proximity of UAS operations to people – at these close distances, 
the higher frequency components of the vehicle noise may not be attenuated as much as they are for 
the greater propagation distances encountered with conventional aircraft. 
 
Larson-Davis 831 SLM 
The LD 831 is a Class 1 SLM. It has a large amount of built in memory (2Gb). In addition to its functions 
as an SLM, The LD 831 can also store weather data obtained externally, which is output from the Vaisala 
WTX-520 weather monitor. It can be powered via internal or external batteries. The unit can be 
controlled from other devices via its USB connections.  
 
Larson-Davis 824 SLM 
The LD 824 is also a Class 1 SLM. The unit has 2 Mb of standard memory. It can powered from internal or 
external batteries. The unit can be control from other devices via a serial I/O port which conforms to RS-
422.  
 
In the equipment set-up used at the CNO IPP, LD 824 Sound Level Meters were employed as gain 
amplifiers for the audio signals feeding into the Sound Designs 744T digital audio recorder.  
 
After the CNO measurement trip, Volpe staff replaced the LD 824 SLMs with dedicated GRAS 12AQ gain 
amplifiers. 
 
Vaisala WXT-520 weather station 
The Viasala WXT-520 weather station provides wind speed, wind direction, temperature, and relative 
humidity information. The unit can also provide atmospheric pressure and precipitation readings. The unit 
outputs data in a number of serial data transmittal standards.  
 
The WXT-520 was used at CNO to provide weather information which was stored on the SLM of the 
primary system (the centerline ground plane microphone).  
 
Sound Designs 744T digital audio recorder 
The SD 744T is a digital audio recorder which records and plays back audio to and from its internal hard 
drive, CompactFlash, or external drives. It writes and reads uncompressed PCM audio at 16 or 24 bits 
with sampling rates between 32 kHz and 192 kHz. It also writes and reads data compressed FLAC and 
audio compressed MP2 and MP3 files. 
 
In the CNO measurements, the SD 744T was used to provide high fidelity digital records of the sUAS for 
possible later analyses.  Information recorded by the SD744T are not included in this report. 

A.2 Set-up 

This section describes the methods of setting up the equipment used at CNO. 
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1. General Equipment Setup  

I. Ground Plate Setup 
i. Place and center ground plate on relatively flat, level terrain at predetermined, 

surveyed, location. 
ii. Use local soil or potting soil, to provide flat, level mounting surface for ground 

plate: remove excess vegetation, rocks, etc. from plate location, place soil in 
area and temporarily install and remove the plate to identify and fill-in any 
voids; compress the soil under the plate to form stable solid surface; nestle the 
ground plate into the soil, making sure that all air pockets are eliminated and 
the edges of the plate are flush with the ground. If necessary, trim local grass, 
etc. within several inches of the edge of the plate. The goal is to integrate the 
plate into the local surface as smoothly as possible, and to minimize abrupt 
transition between acoustical surfaces. 

II. Microphone Setup 
i. Screw (3) spider legs into mic preamp collar assembly. 

ii. Attach microphone to LD preamplifier – back preamp through spider collar 
before connecting cable.  

iii. Attach 100’ microphone cable to preamplifier, and suspend cable above plate 
using cable support inserted into ground adjacent to plate. 

iv. Route 100’ mic cable to instrument table and connect to top input of (blue) 
splitter device. 

 

 
Figure 19, Ground plate & Mic Setup 
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III. Pole Microphone Setup 

i. Extend tripod and place at predetermined, surveyed, location.  
ii. Attach two-piece plastic mic holder to tripod. 

iii. Unscrew upper section of mic holder and run end of 100’ LD mic cable through 
cut-away in lower section of mic holder and thread through upper section. 

iv. Screw upper section of mic holder back onto lower section and tighten set 
screw after preamp has been moved as far upward as it will go. 

v. Remove protective cap from preamplifier and carefully mount microphone 
capsule by rotating CW until connection is firm. (Do not over-tighten.) 

vi. Position microphone for grazing incidence – for centerline microphone, this 
means the body of the preamp will be parallel to the ground and perpendicular 
to the ground track; for sideline locations, the angle will be dependent upon the 
intended altitude of the aircraft and the sideline distance (this should be 
determined in advance, and a protractor should be provided in the mic kit, if 
anything other than 45 degrees.) 

vii. Adjust tripod height so that mic diaphragm is 4 ft. above ground level. 
viii. Install foam windscreen on microphone.  

ix. Secure tripod (using stakes, weights and zip ties, as needed). 
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Figure 20, Tripod Microphone Setup 

 
2. Instrument Table Setup 

I. Time Code Generator 
i. Connect GPS antenna to antenna input at rear of MasterClock GPS-200A.  

ii. Position the antenna to allow for best possible exposure to the sky, away from 
other instrumentation.  

iii. Insert DC power cable to DC input jack at rear of 200A (using the cigarette-to-
alligator clip assembly). 

iv. Connect the RS232 to BNC adapter to the RS-232 output (rear) of the 200A; 
connect the time code BNC to LEMO cable to the RS232 to BNC adapter. 

v. Turn on 200A time code generator by attaching alligator clips to appropriate 
terminals of battery (red to red, black to black: red = positive voltage).  A solid 
green light indicates power (small alligator clips shown in Figure 22, the bigger 
alligator clips belong to the 744T recorder). 

 



        CNO IPP Noise Measurements    43 

 
Figure 21, MasterClock Time Code Generator 

 

 
Figure 22, MasterClock Time Code Generator battery connection - Step v 

 
3. 744T Recorder 

 
I. Place a blank SDHC flash media card into the SD-to-CF adapter. 
II. Carefully orient the loaded SDHC-to-CF adapter with the label facing up and pin slots 

facing the 744T, then insert into the compact flash slot at the rear of the 744T.  Do not 
force as the connector pins are delicate.   

NOTE:  To avoid potential data corruption, it is good practice to install and remove the 
SDHC media card only when the 744T is turned off.  
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Figure 23, 744T Recorder – CF slot 

 
III. Attach the 4-pin LEMO connector end of the 744T power cable to the DC input jack on 

the right side of the 744T.  
IV. Connect BNC to XLR adapters to the input connectors for channels 1 & 2. 
V. Use small BNC cables to connect signals from each microphone from (blue) signal 

splitter output to 744T input adapters.  
 

 
Figure 24, 744T Recorder - Right Side Jacks for Power & Time Code 
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 Figure 25, Table Setup 

 
 

 
4. 744T Audio Recorder 

 
I. Turn on the 744T by holding the power button for 1 second. 
II. A complete configuration file has been pre-loaded to the 744T. To restore/reload the 

configuration, go to MENU>Quick Setup>Load from INHDD, press check mark button to 
load. Additionally, a separate 744T settings table has been provided for reference. 

III. Time Synchronization 
i. The time code generator does not set date, however, the correct date should 

have been set during equipment preparation. Check front panel, top right 
corner, to confirm. If date is incorrect, set manually.  Go to MENU > Time/Date: 
Set (parameter #62).   

ii.  
iii. Next, synchronize clock to UTC. Ensure that the green light on the front panel of 

the MasterClock 200A flashes 1x/second.   
1. This indicates that GPS lock has been obtained.  In the event that the 

light is solid, or flashing 2x/second, reposition the GPS antenna until 
GPS lock has been obtained. 

iv. Connect the LEMO end of the BNC to 5-pin LEMO cable (from the MasterClock 
200A) to the timecode input of the recorder. The 744T will automatically jam its 
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internal system time with the GPS time as soon as the TimeCode generator is 
connected. 
 

NOTE: It is recommended to check time synchronization across all systems, included 
those systems being used by partner organizations participating in the same noise 
measurement. 

 
5. LD 831 Sound Level Meter(s) 

I. Insert fresh batteries and power device on. 
II. Set the Clock and Date manually, using 744T display as reference. 

i. Navigate to the Time/Date settings page in the LD831 menu 
ii. Manually adjust the LD831 system time to the nearest (future) rounded minute, 

and wait for the 744T to arrive at the chosen time. 
iii. Select the “Save” option as soon as the 744T display time arrives at the time 

entered in the LD831 menu. 
iv. Confirm the difference in displayed system times on the LD831 and 744T is less 

than 1.5 seconds. 
 

6. Calibrate 

 

 
Figure 26, Field calibration of inverted ground plane microphone 

 
 Use the “Deployment Calibration” log-sheet to document levels and recording times 
a. Meter Calibration(s) 

i. Apply the calibrator to the microphone system. 
ii. Turn the calibrator on to generate a 94 dB, 1 kHz tone.  

iii. Press TOOLS button on the meter.  Use ↑↓ to highlight Calibration.  Press √ to 
select. 

iv. Press √ again to enter Calibration menu.  Ensure that Cal Level is set to desired 
level (94 dB). If not, select (√) Cal Level; use arrow keys to change value, and √ 
to enter appropriate level.  
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v. Use ↑↓ to highlight Calibrate, and then (√).  You will be prompted to make sure 
calibrator is active.  If so, select (√) YES.  Wait while calibration adjustment is 
performed.   

vi. Calibration is complete when the screen displays the Calibration readout with 
date, time and offset. Log offset to calibration log sheet.  

vii. Use right soft key to go to Sensitivity tab and log measured sensitivity (mV/Pa). 
A reading of 10 to 13 mV/Pa would be considered adequate. 

 
 

b. Set Reference Level Range on 744T 
i. Apply the calibrator to the microphone system and generate a 94 dB, 1 kHz tone 

(see above). Allow system to settle for 1 minute. The signal will be visible on the 
front-panel input level meter on the 744T when connected properly. 

ii. Ensure that switch above input is set to “MIC”. 
iii. Adjust the input level.  

1. Use 744T menu parameters 31 - 33 and adjustment knob on the right 
side panel of the 744T to adjust the system gain as necessary (roughly -
4dB FS). 

 
Note: Once set, this level range will be used for data collection and must not be 
readjusted without recording a new 94 dB SPL calibration reference tone at the new gain 
setting and a clear notation in the log of when the change occurred. 

 
 

c. Dummy Mic Test (Optional) 
i. Remove the microphone from the preamp and temporarily place back in case. 

ii. Attach the dummy microphone in place of the microphone. 
iii. Wait 1 minute and record system noise floor for at least 30 seconds on both the 

744T and LD 831. 
iv. Note levels for LAMax, LZS. 
v. Check 1/3 octave band page for frequency “spikes”. Also, you may attach 

headphones or earbuds to check for audible noise interference. 
Note: you will need to adjust the headphone setting using Menu select knob 
(right side) to monitor appropriate inputs/tracks. Headphone volume knob is 
located on left side. 

vi. Remove dummy mic and reapply microphone. Wait 1 minute. 
 

d. Record Calibration Tones on All Devices 
i. Press Run/REC on both the 744T and the LD 831, and collect at least 30 seconds 

of the calibration signal.  Ensure that the levels indicated on both devices are as 
expected and note in calibration log. Press ■ (Stop) on both devices when 
complete. 
 
 
 

e. Final Ground Mic Setup 



        CNO IPP Noise Measurements    48 

i. Slide narrow portion of spacer bar between ground plate and microphone until 
the microphone touches the top of the spacer bar. Tighten the plastic set screw 
to lock the mic/preamp into place. 

ii. Place microphone into top of semispherical windscreen and position so that the 
diaphragm is ¾ distance from the center of the plate to the trailing edge of the 
plate.  

 
 

Additional Information 
 
744T: 
Use the headphones to occasionally monitor the input signal(s) to ensure that there is no audible noise 
interference or anomalies.  For proper headphone signal routing, the control knob on the right side of 
the 744T may need to be toggled. 
 
There are a number of helpful indicators on the front panel LCD display.  It is recommended to 
occasionally monitor the following parameters: 

1) Battery Level Indicator (upper left corner) – shows voltage level of external power source. 
2) File Name Display (upper center) – for log entries  
3) Time Code Display (center) 
4) Storage Media Status (left row) – indicates record time remaining on available media.  CF = 

removable Compact Flash; IN = internal hard disk drive, and EX = external drive.  An asterisk to 
the left of each media indicates that the medium is selected to record. 

5) SD/Compact Flash card in the 744T is NOT hot-swappable. 744T must be powered down before 
extracting the external storage card. 

6) Input Peak Warning LED (upper left of front panel, second row of lights from top) – This row of 
four red LEDs corresponds to each input channel and serves as a (-3 dB) warning that the input 
signal is approaching an overload condition. 

7) To start a new file while the 744T is recording (file split), press the “REC” button on the front of 
the console. 

 
LD 831: 
From the “Live” tab, use up/down arrows to toggle to additional displays such as 1/3 octave-band and 
date/time, power, memory, etc. 
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Appendix B: Volpe IPP Site and Aircraft 
Information Questionnaires 

IPP Noise Research 
Test Site 

Questionnaire 
03MAY2019 

 

 

I. Please provide availability for scheduling a site-scoping visit (1 day) for Volpe personnel to visit, 
observe, and evaluate the site and communicate and coordinate with LP technical staff on security, 
safety, communications, conductance of flight testing, test-fitting of tracking system on aircraft, etc. 
 

II. Please provide responses to the following questions/requests: 
 

A. Noise Research Test Site: 
For the noise flight testing, Volpe requires a location that is controlled by the Lead Participant that is 
suitable for noise research testing: a large, flat, open area, free from obstructions, line-of-sight 
blockages and noise reflecting surfaces, accessible to – and safe for – Volpe team personnel, with low 
background noise. 

1. Please provide a description of the site, including photos if possible, indicating suggested 
location for microphones and operator stations 

2. Please provide latitude/longitude coordinates for the site (high resolution, if available, as we will 
use these to predict the GPS constellation availability during our research visit.) 

3. Is there room for aircraft to cycle through takeoff, landing, flyover and other operational 
procedures such as: hovering, orbiting, station-keeping, simulated delivery, etc. 

4. Can we access the research site via rental vehicles? (Are there security procedures we need to 
follow? Are off-road/ 4WD vehicles required/recommended?) 

5. Are there any other security procedures, aside from site access? (Do we need to obtain 
personnel clearances in advance? Are there limits on times when site is accessible? i.e., how 
early/late can work be conducted? Is there a regular grounds keeping schedule – mowing, 
watering, etc?) 

6. What are the communications protocols for the site? (Is there cell phone coverage? Do we need 
aircraft radios? If needed, can LP provide Volpe personnel with radios?) 

7. Are WAAS or other DGPS correction signals available? 
8. Would our field equipment be secure if unattended? 
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9. Is there access to toilets? 
10. Is there access to food and water in the local area? 
11. Is there an accessible indoor area that can be secured for equipment staging, storage, battery 

charging, etc? 
12. Where is the closest accessible indoor area that can be used for shelter from hazardous 

weather?  
13. Is AC power available in the field, i.e., at testing locations? (Not needed, but could be useful.) 
14. Are there days of the week that your IPP site has lower vehicle traffic/use?  Is it possible to 

restrict IPP-related (and any other) activities on those days to focus on the vehicles being 
researched?  How far in advance would you recommend posting a notice that the site will have 
restricted vehicle traffic on the research days? 

15. What issues have you had operating UAVs at this site? (Interference from birds or other wildlife? 
Human activity? Anything that might interrupt testing?)  

16. Please list other dominant noise sources in the area (i.e., generators, roadway noise, train 
tracks, etc.)  

17. What is the nearest source of manned aircraft activity? Is there any expectation of interference 
with our planned operations? 

18. Are there any concerns or prohibitions on photography? Volpe typically uses photography to aid 
in characterizing the environment at the site, provide illustration of the vehicles being tested, 
and for documentation and marketing of the research team activity. 

19. Please provide a contact and location info for shipping one to two pallets of instrumentation 
and supplies for up to two weeks prior to measurement trip (Volpe team will need access to 
these materials upon arrival. If a suitable storage location is not available, we may be able to 
have equipment delivered to local hotel.) 
 

 

B. Locale: 
1. Please provide local hotel recommendations, considering proximity, local traffic conditions, 

construction, major events, etc. 
2. What is the nearest major airport to the site? 
3. Travel time by car from nearest major airport to site? 
4. Name and address of nearest medical facility? 
5. Any other location-specific concerns we should be aware of? 
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IPP Noise Research 
Aircraft 

Questionnaire 
03MAY2019 

   
 

(Please complete one form for each aircraft to be tested.) 
 
1. Vehicle manufacturer:___________________________________________ 
2. Vehicle model (and version):______________________________________ 
3. Registration number: ____________________________________________ 
4. Modified?   yes  (if yes, describe on separate page)  no 
5. Vehicle configuration: 

 Rotorcraft: # of rotors_____ # of blades per rotor_____ 
  Rotor diameter_____ 
  Ducted?    yes   no 
  Co-axial, counter-rotating?  yes   no 

 Fixed-wing:  prop # of props____ 
    Configuration:  pusher 
       tractor 
       hybrid 
   other specify: (describe on separate page) 

 Hybrid: describe: (on separate page) 
6. Power method: 

 Electric 
 Internal combustion 
 gas turbine 
 hybrid describe: (on separate page) 
 other describe: (on separate page) 

7. Flight Controls: 
 Movable aero surfaces 
 Differential thrust 
 Vectored thrust:  tilt-rotor 
    tilt-wing (or other mounting surface) 
    other  describe: (on separate page) 

8. Mass properties: 
Dry weight without payload____ 
Maximum TOW____ 
Maximum payload capacity____ 
CG Range Limits:  Lateral:____  Longitudinal:____ 
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9. Size: 

Maximum dimension____ diameter 
     wingspan 
     length 
     height 
     width 

10. Payload accommodation:   none 
 internal describe: (on separate page) 
 external describe: (on separate page) 

11.  Flight performance: 
 VTOL 
 STOL  
 CTOL (conventional horizontal flight) 
Are any external aids, mechanisms, or procedures required for Takeoff or Landing?  
yes  describe: (on separate page)   no 
Is there a physical transition to horizontal flight? 
  yes  describe: (on separate page)   no 

12.  Endurance: 
What is the maximum available flight duration between refueling/battery swaps? ____ 
Expected flight duration w/ 1-pound payload?____ 
What is the turnaround time for refueling / battery swap? ____ 
What is the availability of fuel refills / batteries?____ 
 

13. Please describe any other unique or unusual characteristics: (on separate page) 
 
 
If possible, please provide photos or technical drawings – overhead and profile. 
For clarification, comments, etc. please contact: 
 
Dave Read 
USDOT Volpe Center 
310-544-9222 (California) 
617-494-6343 (Massachusetts – forwards to CA) 
David.Read@DOT.Gov 
 
 
 

  

mailto:David.Read@DOT.Gov
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Appendix C: Volpe START Aircraft 
Position Tracking System User Guide 

C.1. Overview 

Survey and Tracking Apparatus for Research in Transportation (START) is a GNSS based vehicle tracking 
and surveying platform developed by Volpe. It is designed to support vehicle noise measurements by 
providing highly accurate positioning and timing information for the widest possible range of vehicles 
and use cases. In order to achieve this high level of adaptability, the platform is built around a core 
which relies on substitutable parts that may be optimized to accommodate the characteristics of the 
vehicle of interest.  
The platform is comprised primarily of low cost consumer off-the-shelf (COTS) products that have been 
configured for the purpose of miniaturizing a system capable of collecting and storing raw satellite 
observations suitable for post-processing. With one system on the ground (Base Station) and another, 
either at a position to be surveyed or mounted on a vehicle of interest (Rover), the two sets of satellite 
observations may be post-processed to produce highly accurate positioning and timing information.  In 
most cases, the relative position of survey points and dynamic tracking data will be within 5 – 10 cm 
accuracy. Such enhanced accuracy, beyond what is possible with a single point solution, is required for 
determining the time-space-position relationship between measurement microphones and the noise 
source. This become especially important where the relative distances are less than those of standard 
aircraft tests. 
The following guidance will identify the hardware component options and then provide step by step 
procedures for the setup and operation of all hardware and software. Additional information is provided 
in the appendices and includes: data integrity verification procedures, troubleshooting guidance, vehicle 
mounting solutions, receiver configuration settings, START component dimensions/weights, and links to 
technical resources for more detailed information regarding system components. 
 

C.2. Hardware 

The following section provides system diagrams for the Rover and Base station setups, followed by a 
complete list of parts which define the various configuration options that are available in the START 
platform. The numbered items represent the generic components required for a functional system 
configuration and the lettered items indicate the available options. Photos of various hardware 
components are also provided. 
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C.2.1 Hardware diagrams 

 

*GNSS Receiver

START Rover Control 
Computer

Running Windows 10
with uBlox u-Center
& RTKLIB Stream 
Server Software

USB Battery Pack:
5V/min. 2A output

4000 – 6000 mAh capacity

             *Antenna Ground Plate

USB A – USB Mini B Cable
(Receiver Cable)

USB A – USB Micro B Cable
(Power Cable)

Integrated antenna cable 
with SMA connector

HDMI Field Monitor

Not to Scale

Wireless “dongle” 
Keyboard

Mini HDMI – HDMI Cable

USB Battery Pack
5V/min. 2A output

min. 20000 mAh capacity

USB A – USB Micro B Cable
(Power Cable)

LEGEND:
Rover Hardware Components
Cables
For Rover configuration setup 
and data capture start/stop 
only

*GNSS receiver, antenna & ground plate may be integrated 
depending on receiver variant chosen for deployment 

*GNSS Antenna

  

Figure 27, START Rover Configuration 
 
 
 
 
 
 

 



        CNO IPP Noise Measurements    55 

GNSS Receiver

             Antenna Ground Plate

USB Mini B – USB A Cable
(Receiver Cable)

Integrated antenna cable 
with SMA connector

Not to Scale

Laptop: Windows 7 or higher with uBlox u-Center Software

12 VDC Battery

Power Inverter

Laptop 
Power 
Supply

GNSS 
Antenna

  

Figure 28, START Base Station Configuration 
 

 

C.2.2 START components list with available options 

C.2.2.1 ROVER 

NOTE:  Vehicle operators will require the physical properties of the START Rover configuration to be 
installed on their vehicle. Refer to Appendix C: Start component dimensions/weights, for details 
regarding typical configuration weights as well as a breakdown of discrete component weights and 
dimensions. 

1. START Rover Control Computer: Windows 10 OS, loaded with uBlox u-Center v19.04 and RTKLIB 
demo 5 b31 or later 
a. ACEPC W5 Pro mini - primary 
b. MeeGoPad T02 – backup 
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2. GNSS Receiver 
a. uBlox NEO-M8T PCB – requires enclosure, portable 
b. uBlox NEO-M8T USB Dongle – ultra portable , can connect directly to computer or use USB 

ext. cable 
c. uBlox NEO-M8T Disc  - integrates antenna and ground plate. Enhanced EMI protection 
d. uBlox NEO-M8T High Gain - integrates antenna and ground plate. Enhanced EMI protection 

 
3. GNSS Antenna: not required with GNSS Receiver options (c) & (d) 

a. Tallysman 4721 antenna – multi GNSS, active, patch antenna, excellent directivity 
b. Maxtenna M1516HCT - GPS/GLONASS, passive, helical design, good EMI resiliency 

 
4. Antenna Ground Plate: not required with GNSS Receiver options (c) & (d) 

a. Aluminum, 2.5” Diameter, 1/16” thickness 
b. Aluminum, 3” Diameter, 1/16” thickness 
c. Aluminum, 3.5” Diameter, 1/16” thickness 

 
5. Rover USB Battery Pack – tradeoff between battery weight and capacity should be considered 

a. 4400 mAh, 5VDC/2A  
b. 5000 mAh, 5VDC/2A  
c. 6000 mAh, 5VDC/2A 

 
6. USB Power Cable: available in lengths from 1’ to 3’, select lengths have right angle connector 

options 
a. USB A-to-USB micro B, shielded 

 
7. USB Receiver Cable: available in lengths from 6” to 6’, select lengths have right angle connector 

options 
a. USB A-to-USB mini B, shielded 

 
8. 64 GB micro SD card – second storage medium for parallel data recording  
9. Mini wireless “dongle” keyboard/touchpad – for interfacing with Start Rover Control Computer 

during configuration 
10. HDMI Field Monitor – used for deployment setup and data capture start/stop only 
11. HDMI-to-mini HDMI cable – connects display to START Rover Control Computer 
12. HDMI(f)-to-HDMI(f) coupler – required to connect HDMI cable to START Rover Control 

Computer 
13. Display Monitor USB Battery Pack – 24000 mAh: for HDMI Monitor, use with any USB A-to-USB 

micro B cable 
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Figure 29, START Rover Configuration with uBlox receiver/antenna 
 

 

Figure 30, START Rover Configuration with Tallysman antenna 
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C.2.2.2 BASE Station 

1. Laptop Computer: Windows OS, loaded with uBlox u-Center v19.04 and RTKLIB demo 5 b31 or 
later  
 

2. GNSS Receiver 
a. uBlox NEO-M8T PCB – requires enclosure and USB A-to-USB mini B 
b. uBlox NEO-M8T USB Dongle – ultra portable, can connect directly to computer or use USB 

ext. cable 
 

3. GNSS Antenna 
a. Tallysman 4721 antenna – multi GNSS, active, patch antenna, excellent directivity 

 
4. Antenna Ground Plate – use full size microphone ground plate, if available 
5. 20 – 22 amp-hour sealed lead acid battery 
6. Power inverter, 400 Watt minimum. 

                      

 

Figure 31, START Base Station Configuration 
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C.3. Field procedures 

C.3.1 Base Station deployment 

The Base Station should be set up and initialized prior to the Rover. To achieve best performance, it is 
important that the Base Station be sited in an open area, free from large reflective surfaces. Allow the 
Base Station receiver to attain a 3D solution and collect data for at least an hour prior to collecting Rover 
data. The Base should always be collecting data while the Rover is in use. The following is a step-by-step 
setup procedure. 

1. Connect Tallysman 4721 GNSS antenna to uBlox NEO-M8T pcb or USB dongle variant by rotating 
the SMA connector clock-wise onto the threaded coaxial connector at the receiver. 

2. Connect the uBlox receiver to the Base Station laptop using a USB Mini B-to-USB A cable. The 
USB dongle version of the uBlox receiver may be plugged directly into the laptop USB port. 

3. To ensure adequate runtime power, connect a power inverter (min. 400 Watts) to a 20 – 22 Ah, 
12 volt sealed lead acid (SLA) battery. Next, plug in the laptop power supply at the inverter and 
insert power plug into laptop power jack. 

4. Place the GNSS antenna on a ground plate and position as far from other objects as the cables 
will comfortably allow.  

NOTE: Do not move this antenna once the Base Station antenna position has been established. If 
testing is occurring over the course of more than one day, it is critical to mark the position and 
accurately reestablish the Base antenna position and directional orientation each time the Base 
Station is setup. 

5. Turn on the laptop. The laptop will supply power to the receiver and antenna via the USB 
connection.  

6. Create a root-level data directory for the START Base Station files to be written. Name data 
folder using the following format: BASE_<test site name>_<date:mmddyyyy>  

7. Set Com Port parameters in Windows:  
a. From the Start menu, right click and select Device Manager.  

Note: Steps to access the Device Manager may vary slightly depending on the version of 
Windows. 

b. Scroll down the Device manager to Ports (Com & LPT) and expand the menu. Depending 
on the driver, you will see the uBlox receiver listed as “uBlox GNSS Receiver”, “USB 
Serial Device” or “uBlox virtual com port”. Note the com port number assignment 
(Figure 32). 

c. Next, double click the receiver port assignment and select the Port Settings tab. Change 
the Bits per second setting to 115200, using the dropdown menu. Other settings should 
use defaults. Click OK and exit Device Manager. 

8. Open the u-Center software using the desktop shortcut. 
Note: for detailed information regarding u-Center functionality, refer to u-Center User’s Guide 
which is located in the C:\Program Files(x86)\Ublox \u-Center folder. 
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a. Using u-Center drop-down menus, go to Receiver > Connection. Select the com port that 
corresponds to the uBlox receiver (step 7b above). 

b. Next, go to Receiver > Baudrate and select 115200. 
c. Load the Base Station Configuration Settings: go to Tools > GNSS Configuration (Figure 

33). Under Configuration file, use browse button to select “M8T_PCB_Base_030419” or 
“M8T_Integr_High+Dongle_Base_030119”, depending on which hardware version of the 
receiver is being used, and press Open. Next, press File > GNSS button to load 
preconfigured settings to uBlox receiver. 

              NOTE: Although the receiver begins searching for satellites and converging on a positioning 
solution as soon as power is applied, a new solution must be attained each time a new settings 
configuration is loaded. This process can take up to several minutes. As satellites become visible, you 
will note activity in the docking windows to the right. 

d. The window in the upper-most right of u-Center is the Data View and indicates current 
latitude/longitude, altitude (re: WGS84 ellipsoid) and Fix Mode, among other useful 
information. Desirable fixes include 3D or 3D/DGNSS, the latter of which indicates that 
WAAS satellites are being used in the solution. Other docking windows can be added (or 
removed), by clicking on their respective taskbar icon, to display parameters of interest 
such as satellite level history, and signal strength (Figure 34).  

e. Next, confirm critical device settings. Go to View > Message View, then maximize the 
message window. At the left, there will be an expandable menu of parameters. Scroll 
down and expand the UBX section, then expand CFG (Config) sub-section which lists the 
receiver configuration parameters: 
i. Click NAV5 (Navigation 5). Under Navigation Modes, the Dynamic Model setting 

should be set according to the use case. Since the Base station is a fixed position, 
“Stationary” will be the appropriate setting (Figure 35).  

ii. Also in the NAV5 settings, under Navigation Input Filters, ensure that “Min SV 
Elevation” = 5 (degrees). 

iii. Go to RATE parameter and ensure that Time Source is set to UTC and Measurement 
Period = 500 ms. 

NOTE: An expanded list of configuration settings with corresponding screenshots of the u-center 
interface can be referenced in Appendix D. Additionally, a detailed explanation of each setting 
can be found in the “u-blox8-M8_ReceiverDescrProtSpec (UBX-13003221)Public” interface 
manual (see Appendix F for link). 

f. Next, expand the MON (Monitor) sub-section and check the following diagnostics: 
i. HW (Hardware Status): Jamming Status indicator should be green (OK) and CW 

Jamming Indicator value should generally be below 20%. If these parameters are not 
met, efforts should be made to mitigate the effects of EMI. Potential solutions 
include repositioning the Base Station or inserting an in-line USB noise filter 
between the laptop and receiver. 

ii. TXBUF (TX Buffer): Pending Bytes column should be all zeros.  
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g. Expand the RXM (Receiver Manager) sub-section and check the following: 
i. Go to RAWX (Multi-GNSS Raw Measurement Data). Ensure stream of GNSS 

observations can be viewed. A new line of data should appear 2x/second. 
ii. Go to SFRBX (Subframe Data NG): Ensure data is updating every few seconds. 

h. Once a 3D or 3D/GNSS Fix Mode (solution status) has been achieved and critical device 
settings (i.e. steps e, f, and g above) have been checked, begin recording data: 
i.     Click the red dot on the Log File toolbar. You will be prompted to choose a directory 
location for the file. Use the location previously established in step 6. Add the prefix 
“Base” to the default uBlox naming convention which indicates the com port and date 
and time that the file was initiated. For example, “BASE_comX_yymmdd_hhmmss.ubx”. 
ii.    Click Save; you will be prompted to download a log file. Select Yes to begin 
recording. Note that the formerly grayed out buttons on the Log File toolbar, i.e., “tape 
shuttle controls” are now active.  

i. The Base station must collect data throughout the measurement. To stop Base station 
data recording and close the active file at the end of the measurements, click the Eject 
button at the far left of the Log File toolbar. This should only be performed after the 
Rover data collection has been completed. 

 
Figure 32, uBlox Device Manager 

 

 
Figure 33, uBlox GNSS Configuration tool 
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Figure 34, uBlox u-center docking windows 

 

 
Figure 35, uBlox u-center Message View menu 

Satellite level history 

Satellite signal strength 

Data view 

Satellite position 
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C.3.2 Rover deployment 

C.3.2.1 Vehicle mounting and considerations 

If using Rover independent of vehicle, e.g., surveying fixed positions, then skip to section 3.2.2. If 
installing Rover on a vehicle, then careful consideration must be given to the selection of components 
and cables when optimizing the hardware configuration. Access to test vehicles is recommended, in-
advance of data collection to evaluate and plan mounting strategy as each vehicle will present unique 
challenges. Factors to consider include: vehicle size and weight, payload capacity, aerodynamics, c.g. 
and inertial properties (especially important in smaller vehicles), dedicated payload area or flat surfaces 
to be used as natural mounting points, ample clearance from rotors/engines and potential EMI sources, 
such as RF antennae. All mounting methods should be tested with the vehicle powered so that potential 
EMI issues may be identified. All START components and their placement must be approved by the 
vehicle operator.  
Generally, the hardware components should be mounted first, with the GNSS antenna always 
positioned to maximize a clear view of the sky in both azimuth and elevation. Cable lengths selected 
should be no longer than required to link components, and safety concerns, such as blade clearance, 
should be assessed prior to the connection of system components. Fine tuning the fit and finish of the 
Rover installation should occur only after functional and safety concerns have been addressed. Appendix 
C contains additional recommendations for START Rover installation and illustrates examples of 
mounting aides and configurations. 

C.3.2.2 Set up and initialization 

The following steps apply whether the system is mounted on a vehicle or being used independently to 
survey points.  

1. Connect GNSS antenna to uBlox NEO-M8T receiver by rotating threaded coaxial connector to 
SMA jack on receiver printed circuit board (PCB) or USB dongle receiver variant. The 
Tallysman 4721 is the preferred GNSS antenna, however the Maxtena antenna may be a 
better choice in space-constrained settings as it does not require a ground plane and may be 
oriented on or off axis.  

NOTE: If volume and weight are not limiting factors, it is recommended to use one of the 
integrated receiver + antenna and ground-plane options which feature enhanced EMI resilience 
and higher gain, which improves signal to noise ratio. 

2. If using the Tallysman 4721 antenna, affix to largest diameter aluminum ground plate 
suitable for application. 

3. Ensure that GNSS antenna has clear line-of-site to open sky. 
4. Connect the uBlox receiver to the START Rover Control Computer using a USB Mini B-to-USB 

A cable. 
5. Connect START Rover Control Computer to fully charged USB Battery Pack using USB micro-B 

(Computer) to USB A (battery) cable. There are three START Rover battery capacities 
available: 4400, 5000 and 6000mAh, however higher capacity means more weight. It is 
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generally advisable to use the highest capacity battery that the vehicle can safely carry 
without degrading its performance. Appendix C.8 contains a table with weights and 
dimensions of key system components, as well as weights for preferred configurations, as 
installed on vehicle. 

6. Power up system: 
a. Press button on Rover battery pack (LEDs will illuminate).  
b. Then, power computer by holding side power button for 2 seconds, or until LED on the 

computer lights up. When booted up, it is typical for the LED to briefly illuminate then 
turn off for a few seconds before it reappears. Do not repeatedly press the power 
button. 

7. Next, set up the equipment to interface with the Rover (Figure 36): 
a. Place the HDMI display on its stand and connect to the large, 24000mAh USB Battery 

Pack. 
b. Connect START Rover Control Computer to HDMI display using the HDMI-to-mini HDMI 

cable and flexible female-to-female HDMI coupler.  
c. Plug in USB dongle for wireless keyboard to open port on START Rover Control 

Computer. Turn on wireless keyboard/touchpad (bottom), then right-click screen to 
open desktop environment. 

8. Check Windows time and date and ensure that it is nominally synchronized (+/- 2 sec) to the 
designated “master clock”. If not: 
a. Place cursor over date/time field at lower right of display, right click, and select Adjust 

date/time.  
b. Check Time zone for appropriate setting.  
c. If enabled, turn off “Set time automatically”.   
d. Next, click the Change button and use the popup to set the proper time, then close out 

of Settings.   
9. Ensure that a microSD card with adequate storage capacity is loaded in the card slot.                      
10. Create a root-level data directory on the C drive for the Rover files to be written.  

a. A test site/date-specific directory should be created for each day of measurements. 
b. Within each daily directory, a folder should be created for every vehicle tested or survey 

performed. Name data folders using the following convention: ROVER_<vehicle name or 
survey point name>_<test site name>_<date:mmddyyyy>  

11. Next, copy and paste the rover data directory to the D drive (microSD card) and add the 
prefix “Backup_”. The Rover data will be recorded in parallel to both directories. 

12. Set Com Port parameters in Windows:  
a. From the Start menu, right click and select Device Manager.  

Note: Steps to access the Device Manager may vary slightly depending on the version of 
Windows. 

b. Scroll down the Device manager to Ports (Com & LPT) and expand the menu. Depending 
on the driver, you will see the uBlox receiver listed as “uBlox GNSS Receiver”, “USB 
Serial Device” or “uBlox virtual com port”. Note the com port number assignment. 
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c. Next, double click the receiver port assignment and select the Port Settings tab. Change 
the Bits per second setting to 115200, using the dropdown menu. Other settings should 
use defaults. Click OK and exit Device Manager. 

13. Open u-Center software using the desktop shortcut: 
a. Using u-Center drop-down menus go to Receiver > Connection. Select the com port that 

corresponds to the uBlox receiver in step 12b. 
b. Next, go to Receiver > Baudrate and select 115200. 
c. Load the Rover Configuration Settings: go to Tools > GNSS Configuration. Under 

Configuration file, use browse button to select “M8T_PCB_Rover_030419”, 
“M8T_Integr_Rover_030119” or “M8T_Integr_High+Dongle_Rover_030119”, depending 
on which hardware version of the receiver is being used, and press Open. Next, press 
File > GNSS button to load preconfigured settings to uBlox receiver.  

NOTE: Although the receiver begins searching for satellites and converging on a positioning 
solution as soon as power is applied, a new solution must be attained each time a new settings 
configuration is loaded. This process can take up to several minutes. As satellites become visible, 
you will note activity in the docking windows to the right. 

d. The window in the upper-most right of u-Center is the Data View (Figure 34) and 
indicates current latitude/longitude, altitude (re: WGS84 ellipsoid) and Fix Mode, among 
other useful information. Desirable fixes include 3D or 3D/DGNSS, the latter of which 
indicates that WAAS satellites are being used in the solution. Other docking windows 
can be added (or removed) to display parameters of interest such as satellite level 
history and signal strength.  

e. Next, confirm critical device settings. Go to View > Message View, then maximize the 
message window. At the left, there will be an expandable menu of parameters. Scroll 
down and expand the UBX section, then expand CFG (Config) sub-section which lists the 
receiver configuration parameters: 
i. Click NAV5 (Navigation 5). Under Navigation Modes, the Dynamic Model parameter 

should be set according to the Rover use case. For most small UA, “Airborne < 1g” 
(acceleration) will be appropriate, however, this setting should be optimized for the 
specific end-use. For example, for very fast moving UA, “Airborne <2g” should be 
used. For surveying microphone positions, this setting should be changed to 
“Stationary”. 

ii. Also in the NAV5 settings, under Navigation Input Filters, for any dynamic use case, 
ensure that “Min SV Elevation” = 0. For “stationary” applications, set to 5. 

iii. Go to RATE parameter and ensure that Time Source is set to UTC and Measurement 
Period = 500 ms. 

NOTE: An expanded list of configuration settings with corresponding screenshots of the u-center 
interface can be referenced in Appendix D. Additionally, a detailed explanation of each setting 
can be found in the “u-blox8-M8_ReceiverDescrProtSpec (UBX-13003221)Public” interface 
manual (see Appendix F for link). 
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f. Next, expand the MON (Monitor) sub-section and check the following diagnostics: 
i. HW (Hardware Status): Jamming Status indicator should be green (OK), although 

yellow (warning) may also be acceptable. The CW Jamming Indicator value should 
generally be below 30%. If these parameters are not met, efforts should be made to 
mitigate the effects of EMI. Potential solutions include repositioning the Rover 
battery, inserting an in-line USB noise filter between the Rover battery and START 
Rover Control Computer and applying shielding material.  

              NOTE: Appendix B: “Troubleshooting guidance”, provides additional information as well  
              as screenshots and tips regarding Monitor diagnostics and potential solutions to issues 
              induced by EMI.  
 

ii. TXBUF (TX Buffer): Pending Bytes column should be all zeros.  
g. Expand the RXM (Receiver Manager) sub-section and check the following: 

i. Go to RAWX (Multi-GNSS Raw Measurement Data). Ensure stream of GNSS 
observations can be viewed. A new line of data should appear 2x/second. 

ii. Go to SFRBX (Subframe Data NG): Ensure data is updating every few seconds. 
h. Once a 3D or 3D/GNSS Fix Mode (solution status) is achieved and critical device settings 

have been confirmed, perform a time check against the acoustic system reference time 
and record a “time hack” event: 
i.     To view START time, go to the NMEA section at the top of the message 
       view and select GxGGA (Global Positioning System Fix Data). UTC time will 
       be displayed at the top. 
ii.    Press Record, when prompted, add prefix “time_hack” to default file name, 
       then press Save to begin recording. 
iii. Coordinate time check and “hack” with acoustics operator. Ensure that the record 

Stop button is pressed at the moment of the audible time hack. 
i. Exit u-Center software via the File menu.       

14. To begin data recording, open RTKLIB “STRSVR” software via the desktop shortcut. Right 
click the icon and select “Open as administrator”. This software functions as a data stream 
server which routes the receiver’s GNSS data from the incoming com port of the START Rover 
Control Computer to directory locations for file recording. 
a. The top row of settings is for the Input Stream. Under the “Type” heading, use the drop 

down menu to select “Serial”. 
b. Under the “Opt” heading, click the button corresponding to the input stream. A popup 

menu will appear to set the input stream serial parameters. Use the drop down menu to 
select the receiver com port (from step 12b) and set the Bitrate (bps) to 115200. Use 
defaults for other settings. Press OK (Figure 37). 

c. Next, set (1) Output Type to “File” using the drop down menu. 
d. Click the corresponding “Opt” button. Using the popup menu, set the output file path to 

the appropriate directory folder established in step 10b. A Windows popup will allow 
you to map to the appropriate directory. 
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e. Enter the File name manually using the following convention: ROVER_<vehicle name or 
survey point name>_<test site name>_<date:mmddyyyy>.ubx (Figure 38). If more than 
one data file is collected for the same vehicle or survey point, then add a sequential 
numerical suffix at the end of the vehicle name. *If a new recording is initiated without 
changing the file name, you will be prompted to rename the file or have the existing file 
overwritten. 

f. Click Save, then OK to close Output File Path popup. 
g. Set (2) Output Type to “File” using the drop down menu. 
h. Click the corresponding “Opt” button. Using the popup menu, set the second output file 

path to the backup data directory located on the microSD card. Using the Windows 
Explorer popup, select the appropriate folder on the “SecureDigital Storage Device (D)”.  

i. Enter the File name manually using the following format: Backup_ROVER_<vehicle name 
or survey point name>_<test site name>_<date:mmddyyyy>.ubx. If more than one file is 
needed for the same vehicle or survey point, then add a sequential numerical suffix at 
the end of the vehicle name. 

j. Click Save, then OK to close Output File Path popup. 
k. Next, click the Options button at the bottom of the STRSVR interface. At the top of the 

options menu, set Buffer Size to 64000 and Period of rate (ms) to 500. Leave defaults for 
other parameters. Press OK. 

l. To begin Rover data collection, click the Start button at the bottom of the STRSVR 
application. Assuming the STRSVR has been properly configured and the receiver is 
sending data, you should observe flashing green status buttons to the left of the stream 
settings. The bytes transferred and bits per second should also be observable on the 
right. Output streams 1 and 2 should indicate the same amount of bytes transferred 
(Figure 39). 

m. It is recommended to allow the Rover to collect data for at least 5 minutes before 
deploying. When ready, disconnect the display monitor from the START Rover Control 
Computer, remove the wireless keyboard USB dongle and turn off the keyboard. The 
Rover is now ready to deploy.  

n. When finished using the ROVER, reconnect the HDMI computer to the display monitor, 
insert the wireless keyboard dongle and turn on the keyboard.  

o. Click the Stop button on the STRSVR software, then exit.  
 
NOTES:  
(1) It is recommended that data integrity checks be performed at pre-planned intervals. This 

may be accomplished by ejecting the microSD media, copying the START Rover data to a 
field laptop, returning the microSD media to the START Rover, then analyzing the data file 
using the VerifyRINEX Software Utility. This process is detailed in Appendix A. 

(2) If you will be redeploying the Rover for continued data collection, assuming adequate START 
Rover battery power is remaining, it is recommended that the Rover remain powered on in 
order to maintain the best possible GNSS solution. However, if the battery is running low, a 
shutdown will be required as the battery is not “hot swappable”. 
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(3) Due to the limited storage space on the START Rover Control Computer, it is recommended 
that data be transferred and archived to both external hard drives and field laptops at the 
end of each day. 

 
Figure 36, Rover interface equipment 

 
 



        CNO IPP Noise Measurements    69 

 
Figure 37, STRSVR input stream options window 

 
 

 

 
Figure 38, STRSVR output stream options window 
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Figure 39, STRSVR window during data capture 
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C.4. Verifying integrity of GNSS observations 

To mitigate the potential for missing or incomplete Rover GNSS data, it is recommended that the data 
contents be verified for completeness at preplanned or opportunistic times during data collection. For 
example, during battery changes or refueling of test aircraft. To accomplish this, VerifyRinex, a console 
application intended to quickly assess completeness and integrity of tracking system data has been 
developed by Volpe. The utility was written and tested for use with the RINEX v3.03 specification.  
Following is a step by step procedure for GNSS data verification using VerifyRinex. 

1. During testing “down time”, remove microSD card from START Rover Control Computer. 
2. Insert card in designated field laptop (a USB card reader will likely be needed). Laptop should be 

preloaded with the RTKLIB suite of GNSS processing tools as well as VerifyRinex software (most 
recent revision available).  

3. Convert proprietary uBlox “.ubx” data file of interest to standardized RINEX v3.03: 
a. Within the RTKLIB folder, right click on “rtkconv.exe” and open as administrator. For 

future ease of access, it is recommended to create a desktop shortcut. 
b. Map Rover data file as the input by clicking upper most directory button along right 

edge of user interface. Navigate to relevant data file and select. Directory location 
should be visible at top drop-down field, under “RTCM, RCV RAW or RINEX OBS” (Figure 
40). 

c. Next, click directory button to the right of the “Output Directory” drop-down field and 
navigate to desired folder.  

d. Under “Format”, to the right of the Output Directory field, use the drop-down menu to 
select “u-blox”. 

e. Ensure checkbox under Output Directory (at far left of UI) is selected as well as top two 
checkboxes under RINEX OBS/NAV…  

f. Set options by clicking on “Options” button at center bottom of UI. Popup will appear. 
g. Set RINEX version to 3.03 using drop- down menu at top left (Figure 41). 
h. Ensure that “Scan Obs Types” is checked. 
i. Under Satellite Systems, check GPS, GLO, GAL and SBS. 
j. Check all boxes under Observation Types and ensure that L1 is checked under 

Frequencies. Click OK to close Options. 
k. Next, click the Convert button to generate RINEX v3.03 files to the output directory. The 

file with the “.obs” extension contains the GNSS observables and will be used with the 
VerifyRinex utility. 

4. Copy the .obs RINEX file into the VerfifyRinex folder, which contains the VerfiyRinex executable, 
input configuration file (VRinput.txt), output file (VRoutput.txt) and logs of detailed timestamp 
information (timestamps.log & missing_timestamps.log). 

5. Next, double-click the RINEX file, generated in step 3, to open. After the header information you 
will see timestamps with subsequent GNSS observables. To check the entire file, note the first 
and last timestamp. If a subset of data is being checked, such as events of interest from a field 
log, then enter those times (UTC). 

6. Open VRinput.txt and enter parameters for the data being verified. The input configuration file 
must be formatted according to Figure 42. The parameters include the name of the RINEX file 
(no spaces or special characters permitted), starting/ending dates and times of data to be 
verified, Rover data sampling rate (Hz), a threshold minimum number of satellites (recommend 
6 – 8) and a binary value to turn off/on the timestamp logs. See Table 43 for a summary of 
required format and parameters. When complete, Save and close VRinput.txt. 
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7. Run the utility by double-clicking VerfifyRinex.exe. The utility parses the RINEX file while 
counting the number of timestamp records that fall within the user-specified window. Based on 
the sampling rate a certain number of records will be expected. The number of located records 
and the expected number of records are displayed on the screen and written to VRoutput.txt. 
Additionally, the number of satellite observations in each record is compared against a 
minimum threshold value and the percentage of records in which the number of satellites meets 
the threshold is also reported. Optionally, both a list of timestamps and satellite counts for all 
records within the user-specified interval is written to the “timestamps.log” and a listing of all 
missing timestamp records (> 1 sec), including duration of gap and start and end points, is 
provided in the “missing_timestamps.log”. 

8. It is generally expected to have near 100% of anticipated records and at least 5 satellites per 
record. Data gaps, if any, should be no more than a few seconds. The timing of missing data 
points is the critical factor though. Special attention should be paid to times when the Rover was 
engaged in flight test events. Based on the completeness of data, a decision may be made to 
collect additional data.   

 

 
Figure 40, RTKConv main window 
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Figure 41, RTKConv options window 

 
 

 
Figure 42, Sample input parameters for VRinput,txt 

 
 

Table 43. VRinput.txt format 
Line number Input field Format / units 

1 RINEX file name filename.obs 
2 Start date YYYYMMDD 
3 Start time HHMMSS 
4 End date YYYYMMDD 
5 End time HHMMSS 
6 Sampling rate Hz 
7 Threshold number of satellites Integer 
8 Optional flag for timestamp output 1 (to write timestamp file) or blank 
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C.5. Troubleshooting guidance 

The following section presents potential problems that could be encountered while using START. It is 
based on user experience and is by no means a comprehensive listing of every issue that could occur. 
For each issue presented below, guidance is given to solve or work around the obstacle. 
 

1. START Rover data dropouts are observed in, either, u-Center’s Satellite Level History display or 
discovered via the VerifyRinex data integrity check. 

Regardless of how the dropouts are discovered, it is likely that the dropout are being caused by 
electromagnetic interference (EMI) from the host aircraft. There are two general types of EMI to 
be concerned with, broad band and narrow band. This is important because they tend to have 
different sources within the aircraft and since the uBlox receiver monitors both, this feedback 
can be used to diagnose and remedy the issue. The goal is to mitigate interference levels to 
tolerable levels as it is generally not possible to complete eliminate it. 
The following procedures are recommended to mitigate EMI to levels that do not compromise 
data integrity: 

a. If not already running, open u-Center software using the desktop shortcut. 

b. Go to View > Message View, then maximize the message window. At the 
left, there will be an expandable menu of parameters. Scroll down and 
expand the UBX section. Next, expand the MON (Monitor) sub-section and 
check the following diagnostics: 

c. HW (Hardware Status) (Figure 43): Jamming Status indicator should be 
green (OK), although yellow (warning) may also be acceptable. The CW 
Jamming Indicator value should generally be below 25% when the START 
Rover is onboard a powered aircraft. If these parameters are not met, 
efforts should be made to mitigate the effects of EMI. Potential solutions 
include repositioning or reorienting the Rover battery, inserting an in-line 
noise filter between the Rover battery and START Rover Control Computer 
and applying shielding material.  

d. An iterative process using the HW jamming indicators in conjunction with 
mitigating efforts will be required to find the right solution or combination 
of solutions. To help accomplish this, a better understanding of key 
Hardware Status (HW) parameters is useful: 

e.  The Jamming Status indicator accounts for total radio frequency 
interference (RFI). This means that both broad and narrow band spectra are 
monitored. However, the indication is relative to the last time the receiver 
attained a valid solution with an “OK” jamming status. A default threshold 
of 3 dBHz is used. If the state changes from OK (green) to Warning (yellow), 
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this means that >3 dBHz RF “noise” has been detected relative to the last 
time the receiver had a valid solution with an “OK” jamming status. A 
Warning (yellow) jamming status is not necessarily a problem though. This 
information must be considered along with the CW Jamming Indicator as 
well as satellite signal levels, as represented by the carrier-to-noise density 
ratio(s) (C/N0)).  A Jamming Status of Critical (red) is always a problem, 
however, and typically means that interference is preventing a valid fix from 
occurring. 

f. The CW (constant wave) Jamming Indicator monitors narrow-band EMI. A 
desirable value is generally under 15%, although this is not an absolute rule 
and can vary depending on local environment. In all cases though, the 
lowest value attainable is desired. Strong sources of CW interference are 
typically driven by telemetry occurring between the aircraft and controller. 
Most aircraft will have multiple antennae and more than one frequency 
used for communicating different types of data, e.g., control information 
versus video feed.  

g. Carrier-to-noise density ratio (C/N0) is a measure of signal power expressed 
in decibel-Hertz (dBHz) and refers to the ratio of the carrier power and the 
noise power per unit bandwidth. C/N0  values are available for every satellite 
received and can be viewed either in numerical or graphic form. The easiest 
way to see C/N0 levels are via the Satellite-Levels docking window as 
indicated by the vertical bars at the lower right of Figure 43. Using the 
Satellite-Levels History window (window showing flags of origin for 
satellites), you can click on the horizontal signal level history bar to see a 
readout of satellite C/N0 as well as its position. Generally speaking, 30 dBHz 
is a good value. In optimal conditions, and depending on the 
receiver/antenna combination, there should be at least 5 satellites over this 
threshold. Low C/N0 levels in open, outdoor conditions, are likely caused by 
EMI jamming.  

Now that we have a basic understanding of the available diagnostics, here 
are a few example scenarios to explain and explore mitigation options.   
 

Scenario 1: Jamming Status = Warning, CW Jamming Indicator = 50% 
In this case, the constant wave (narrowband) interference is considerably higher than normal and the 
jamming status of “warning” is likely being driven by the CW levels. The primary RF noise source is 
probably propagating from the various aircraft antennae which are often concealed in spaces like the 
landing gear or wings. If antenna placement can be determined, it is recommended to reorient or 
reposition START Rover components away from the source. An iterative approach using the jamming 
indicators will be needed. The START Rover battery is the most susceptible component in terms of 
introducing stray RFI into the system, hence this is a practical starting point. The GNSS receiver/antenna 
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may also receive stray RF. Repositioning can be effective laterally or vertically. Sometimes, simply 
rotating a component so that the USB connection faces another direction can be useful. The in-line noise 
filter should also be tried in conjunction with this approach. It has been seen to reduce some CW 
interference by as much as 50%. The RF resistant “Faraday Pouch” may also be a useful form of shielding 
for the battery, however, payload considerations must be considered when adding components to the 
START configuration. 
 
Scenario 2: Jamming Status = Warning, CW Jamming Indicator = 25% 
This is a borderline situation where, although there is considerable CW interference, repositioning 
components may not be necessary. It is not clear if the Jamming Status Warning is being caused by 
narrowband or broadband EMI. It may be a combination of both. Check the C/N0 levels. If there are at 
least 6 or 7 satellites over 30 dBHz then the GNSS signal strength should be sufficiently high to enable 
robust data collection. If multiple signals are over 40 dBHz or higher, then confidence levels are even 
higher. It is, however, recommended to insert the in-line USB noise filter between the Rover battery and 
the Start Rover Control Computer. Recheck jamming indicators, as well as C/N0 levels for indications of 
improvement. 
 
Scenario 3: Jamming Status = Critical, CW Jamming Indicator = 40% 
This scenario is interesting because data collection is failing but the CW Jamming, although considerable, 
is likely not high enough to cause a critical state on its own. The failure is probably being driven by 
broadband EMI. This makes it harder to pinpoint the source, however, poor shielding on aircraft 
components, such as the motherboard, can emit a strong broad-spectrum EMI field. C/N0 levels would 
be expected to be very low in these conditions. Installing the in-line USB noise filter and “Faraday 
Pouch” are still the first line of defense. Check indicators and C/N0 levels for improvement. If the 
Jamming Status is not improved to Warning and the CW Jamming reduced to 20%, then iterative 
repositioning of components will be necessary. If aircraft appropriate, raise the antenna/receiver 
assembly by stacking an additional mounting apparatus. Experimenting with Rover battery mounting 
orientation or position is also recommended but consideration must be paid to proper load balancing. 
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Figure 43, u-Center hardware status window 

       

2. START (either Base or Rover) has been properly setup, powered on, and configured but no 
satellites are being received after several minutes of searching. 

Ensure that GNSS antenna has a clear view of the sky. Within u-Center, go to Receiver menu and 
select Debug Messages. This action will send debug messages to the receiver and activity should 
be seen in the docking windows within a few minutes. 
 

3. Forgot to initiate data recording. 

While powered on and after attaining a solution, the uBlox receiver continuously collects data to 
a SQLite database on an internal 4MB flash memory. In the event that the recording of the data 
log was not initiated, it is still possible to recover the last, approximately, 5 minutes of data 
(limitation based on configuration settings and 4MB flash size). To recover, go to File > Save. A 
“Save As” pop up will appear. Rename the file according to protocol and choose appropriate 
directory, then press Save. Data from the last 5 minutes will be captured and new data will 
continue to record until the file is stopped or Ejected. 
 

4. Loading of START Configuration file fails. 

This is a rarely seen issue. This is a uBlox bug and is best remedied by switching out the Start 
Rover Control Computer. 
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C.6. Tracking system mounting methods 

The different configurations of the START Rover system allow for a wide variety of mounting solutions. 
There are, however, a few questions that should be asked to determine the optimal mounting solution.  

• What to mount? Optimize START Rover hardware configuration based on vehicle characteristics, 
(e.g., EMI sources, size and weight constraints) 

• Where to mount? Determine what will fit on the aircraft dimensionally, and what parts of the 
aircraft can be used as attachment points 

• How to mount? Choose the best aides to safely secure the system to the vehicle 

There are a number of supplies and tools available. What works best will vary from vehicle to vehicle.  
What to Mount  
The current preferred component set uses the uBlox NEO-M8T High Gain integrated receiver and 
antenna, with the 4400 mAH Rover battery. This configuration provides the best performance with a 
relatively low system weight. To further reduce weight,  use shorter/lighter cables and minimize 
attaching hardware, if viable. If weight is still an issue, switch to the uBlox NEO-M8T Disc. This option 
has less weight and a simpler mount.  
Where to Mount 
There are multiple goals in positioning the components on the aircraft. Key factors are: 

• placing the antenna to allow a clear view of the sky in both azimuth and elevation 
• finding locations on the vehicle that are flat and smooth (if available) and clear of propellers 

and other moving or functional features 
• balancing the weight of the system on the vehicle as to not impact flight performance, e.g., 

aerodynamics, c.g. and inertial properties (especially important in smaller vehicles). Placing 
parts close to the center of the vehicle helps with balance, as does placing the heaviest 
components opposite of each other or opposite from heavy points on the aircraft (counter-
balance). 

• placing receiver and antenna away from known EMI sources 

How to Mount 
Mounting must be temporary and should not mar or damage the vehicle, however, must also be secure 
to the aircraft with no chance of components coming loose during the test. Use materials that will 
accomplish this with the least impact on the vehicle. Table 44 below shows various mounting tools and 
materials. 
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Table 44. Tracking system mounting aids 

Components and materials Examples 
uBlox 45mm and 90mm mounts – These 3D 
printed mounts are made at the Volpe Center 
for the uBlox hardware. They are stackable to 
provide flexibility to move the receiver away 
from the aircraft propellers and possible EMI 
sources. 
 

 
“Dual Lock” fastener – This material is similar 
to Velcro and provides a strong grip with less 
play than fabric Velcro. It is available in 
regular and low profile. 
 
 

 
Cable “zip” ties – Strong, versatile 
connections, but require a place of 
attachment. Smaller ties are important for 
managing cables. 
 

 
Foam –  High-density foam is important for 
filling gaps between curved and flat surfaces. 
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1. Make sure all hardware, cables and mounting materials are clear of the propellers throughout their 
full range of motion. 

 

 
Figure 44, START component mounting examples 

 

2. Make sure you can access important buttons, connections, ports and card slots. This can be as 
simple as confirming the component is facing the right way. 

 
Figure 45, START computer mounting example 
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Figure 46, START High Gain antenna mounting example 

 
uBlox NEO-M8T High Gain integrated receiver 

 
Figure 47, START uBlox integrated receiver/antenna example 

 
 

 
Figure 48, START with Tallysman antenna mounting example 



        CNO IPP Noise Measurements    82 

C.7. Receiver configuration settings 

The uBlox NEO-M8T GNSS receiver is a complex device with numerous settings which can be optimized 
for a wide array of precise timing and positioning applications. In most cases, the settings are either not 
relevant for our end-use or the default value is sufficient. This section will illustrate the subset of 
settings that define the START configuration and are most important for the successful collection of 
GNSS observables. It is not recommended to stray from the settings of the START configuration files, 
unless there is a complete understanding of the parameter. Although there are a total of four START 
configuration files, only a few settings differentiate the four configurations. These differences are based 
on whether the application is static (Base Station/Point Survey) or dynamic (Rover), as well as the choice 
of receiver hardware. Configuration differences will be noted for the relevant parameters. 
To access configuration settings, Open u-Center software using the desktop shortcut: 

1. Go to View > Message View, then maximize the message window. At the left, there will be an 
expandable menu of parameters. Scroll down and expand the UBX section, then expand CFG 
(Config) sub-section which lists the receiver configuration parameters. Table 45 below lists the 
non-default configuration parameters for START. To access settings, click on CFG (Config) 
Parameter listed in the Table. To apply any change in settings, the “Send” button in the lower 
left corner of u-Center must be clicked subsequent to changing a parameter in the GUI. This 
action will send the new settings to the receiver.  

NOTE: *Indicates parameters that vary across the four START configuration files. 
 

Table 45. START configuration settings 
CFG (Config) Parameter START Configuration Settings 

GNSS (GNSS Config) -Check “Enable” for GPS, min = 8, max = 16 
-Check “Enable for SBAS, min = 1, max = 3 
-Check “Enable” for Galileo, min = 4, max = 8 
-Check “Enable for GLONASS, min = 4, max = 12 

INF (Inf Messages) Protocol – select NMEA, then in column #3, check Error, 
Warning, and Notice. No additional protocols require 
information messages 

*ITFM (Jamming Interference Monitor) Ensure “enable jamming/interference monitor” is checked. 
*Antenna Type depends on hardware choices. Select 
“Active” for Tallysman 4721 and uBlox NEO-M8T High Gain 
integrated receiver/antenna (square plate design). Select 
“Passive” for other hardware options 

LOGFILTER (Log Settings) Check “Recording enabled” 
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CFG (Config) Parameter START Configuration Settings 

MSG (Messages) The following messages should be selected from the drop 
down menu and the USB box should be checked for each: 
MON-HW2, Mon-HW, Mon-IO, MON-TXBUF, NAV-PVT, 
NAV-SBAS, NAV-STATUS, NAV-SVINFO, RXM-RAWX, RXM-
SFRBX, NMEA-GxGGA, NMEA-GxGGL, NMEA-GxGSA, NMEA-
GxGSV, NMEA-GxRMC, NMEA-GxGVT, NMEA-GxZDA 

*NAV5 (Navigation 5) *For Base Station & Survey applications set Dynamic Model 
to Stationary and Min SV Elevation to 5 (deg) 
*For Rover/Dynamic applications set Dynamic Model to 
Airborne <1g and Min SV Elevation to 0 (deg) 
Default values should be used for all other parameters 

PMS (Power Management Setup) Full Power or Balanced may be selected from drop down 
menu 

PRT (Ports) Select USB from the Target drop down menu. Protocol in & 
Protocol out should be set to UBX+NMEA. All other Targets 
should be set to None. 

RATE (Rates) Time Source = UTC time, Measurement Period = 500 ms 
Default values should be used for other parameters 

SBAS (SBAS Settings) Subsystem = Enabled, PRN Code – select WAAS.  
Default values should be used for other parameters 

USB (Universal Serial Bus) Power Mode – select Bus Powered, 100 mA 
Default values should be used for other parameters 

 
 
 
 
 
 
 

  



        CNO IPP Noise Measurements    84 

C.8. START component dimensions & weights 

 
Table 46. START component physical properties 

Function Component Weight 
(g) 

Length (mm) Comments 
X Y Z 

Receiver Ublox NEO-M8T PCB (no 
enclosure) 

9 49 19 16 No enclosure 

Receiver uBlox NEO-M8T USB Dongle  16 75 26 13   
Receiver uBlox NEO-M8T Disc   45 80 80 14 with integrated 

antenna + ground 
plate 

Receiver uBlox NEO-M8T High Gain  80 100 100 25 with integrated 
antenna + ground 
plate 

Rover Control 
Computer 

ACEPC W5 Pro mini  52 114 40 15   

Rover Control 
Computer 

MeeGoPad T02 50 116 44 11   

Rover Battery 4400 mAH Batteries 115 95 46 22   
Rover Battery 5000 mAH Batteries 124 98 47 22   
Rover Battery 6000 mAH Batteries 148 99 47 22   
GNSS Antenna Tallysman 4721 72 38 38 14.3 use with PCB or 

Dongle receiver 
uBlox mount 45mm mounting plate (all 

plastic) 
7     

uBox mount 90mm mounting plate (all 
plastic) 

12     

USB Filter Jitterbug USB Filter 10     
*USB interconnect cables not included 

 
Table 47. As-installed weights 

Installation examples 

Typical Type 1 installation 
• uBlox NEO-M8T High Gain 
• 4400 mAH Battery 
• ACEPC W5 Pro mini 
• 45mm uBlox Mount 
• 90mm uBlox mount 
• Assorted cables, zip ties, velcro, and foam 
• Total with USB noise filter – 328g 
• Total without USB noise filter – 318g 

Typical Type 2 installation – lightweight configuration 
• uBlox NEO-M8T Disc 
• 4400 mAH Battery 
• ACEPC W5 Pro mini 
• 45mm uBlox Mount 
• Assorted cables, zip ties, velcro, and foam 
• Total with USB noise filter – 282g    
• Total without USB noise filter – 272g 
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Installation examples 

Typical Type 1 installation - with longer life 
battery  

• uBlox NEO-M8T High Gain 
• 6000 mAH Battery 
• ACEPC W5 Pro mini 
• 45mm uBlox Mount 
• 90mm uBlox mount 
• Assorted cables, zip ties, velcro, and foam 
• Total with USB noise filter – 362g 
• Total without USB noise filter – 352g 

Typical Type 3 installation – separate antenna 
• uBlox NEO-M8T USB Dongle  
• Tallysman 4721 Antenna 
• 4400 mAH Battery 
• ACEPC W5 Pro mini 
• 45mm uBlox Mount 
• 90mm uBlox mount 
• Assorted cables, zip ties, velcro, and foam 
• Total wth USB noise filter – 355g  
• Total without USB noise filter – 345g 
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C.9. Product resource links 

uBlox M8: Receiver Description, including Protocol and Specifications Documentation: 
https://www.u-blox.com/sites/default/files/products/documents/u-blox8-
M8_ReceiverDescrProtSpec_%28UBX-13003221%29_Public.pdf 
 
uBlox u-Center software download (includes User Guide in installation): 
https://www.u-blox.com/en/product-resources/field_file_category/evaluation-software-
222/field_file_products%253Afield_product_tech/raw-data-172 
 
RTK Explorer: 
https://rtklibexplorer.wordpress.com/ 
  

 

 

 

  

https://www.u-blox.com/sites/default/files/products/documents/u-blox8-M8_ReceiverDescrProtSpec_%28UBX-13003221%29_Public.pdf
https://www.u-blox.com/sites/default/files/products/documents/u-blox8-M8_ReceiverDescrProtSpec_%28UBX-13003221%29_Public.pdf
https://www.u-blox.com/en/product-resources/field_file_category/evaluation-software-222/field_file_products%253Afield_product_tech/raw-data-172
https://www.u-blox.com/en/product-resources/field_file_category/evaluation-software-222/field_file_products%253Afield_product_tech/raw-data-172
https://rtklibexplorer.wordpress.com/
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Appendix D: Individual Event Noise 
Measurement Data  

D.1. Measurement data introduction 

Acoustic and meteorological data collected during the noise measurement program for each individual 
aircraft noise event are presented on the following pages. These data were used to obtain the average 
value data per aircraft and event type that are provided in the body of the report in section 3. A uniform 
data presentation format is used in this appendix for the three rotary-wing vehicles; the fixed-wing X-8 
format is slightly different due to differences in takeoff operations between rotary- and fixed-wing 
vehicles. 

D.2 Rotary-wing Vehicles 

The rotary-wing vehicles have data presented in two different groups: one set of tables for fully dynamic 
operations and other set for operations which contain a mix of static and dynamic components. The fully 
dynamic operations are the slow and fast overflights. The operations which contain a mix of dynamic 
and static components – referred to below as ‘semi-static’ – are the takeoff, landing, and infrastructure 
inspection operations. 

D.2.1 Dynamic operations  

The dynamic operations – the slow and fast overflights – each have four tables. The first three tables 
show data for the LAMax (one table) and SEL (two tables) metrics with a record of data (i.e. a row in 
each of the tables) for each pass. The fourth table shows a set of statistical data for the passes. These 
tables are described below.  

D.2.1.1 LAMax table  

These tables provide the maximum A-weighted, slow time-averaged noise level for each pass. The tables 
show the same type of information for each of the three microphones. Note that these tables use the 
symbol “LASmx” in the header. 
 
The leftmost column provides the pass ID number that was used by test personnel to coordinate logging 
information during the measurement. The next column provides the time of the event as logged by the 
Flight Director.  
 
The next column shows the time at which the LAMax for that event occurred. Note that values in this 



        CNO IPP Noise Measurements    88 

column indicate the time of sound reception, not emission. (For the relatively small sound propagation 
distances typical for this testing, the difference between emission and reception time should be 
extremely small.) The values are those stored in the LD831 SLM data files.  The next column provides the 
measured LAMax values. The next column provides these levels extrapolated to a normalizing distance 
of 400 feet. This extrapolation only accounts for the spherical spreading of sound, based on the 
measured aircraft position relative to each microphone at the time of LAMax; no other adjustments, 
such as for atmospheric absorption, are included. Note that this normalization distance is the common 
distance used in a number of prior Volpe/FAA reports to allow simple comparison of different UAS 
vehicles at a common distance. The last column in each microphone set is the three-dimensional slant 
distance between the microphone and the aircraft at the time of LAMax.  

D.2.1.2 SEL table  

The Sound Exposure Level tables are formatted in a similar manner to the LAMax tables, with the Pass ID 
and the logged event times repeated from the LAMax table. Noise data are provided in the middle 
columns, and the rightmost columns provide the aircraft speed and direction of flight. Note that these 
tables use the symbol “LAE” in the header. 
 
For each microphone, the first column provides the duration of the event. SEL is a time-integrated 
metric where the sound energy for the entire noise event is normalized to a reference duration of one 
second. The actual duration is determined by identifying the “10 dB down” points, relative to the LAMax 
level for the event. For this study, the SEL values were computed by automated post-processing of the 
stored A-weighted time history values from the SLM using an in-house Fortran utility. The process starts 
25 seconds before the time of LAMax and ends 25 seconds afterward. If the time-history levels within 
this period do not exhibit a clear 10 dB rise and fall then the SEL event duration is set to 50 seconds and 
the associated data quality column (labelled “10dBA?”) is set to “no”. Passes where the 10 dB down 
criterion was met contain the word “yes” in this column. The next column shows the SEL level itself. 
Note that the calculated SEL is still shown, even if the 10 dB down criterion was not met. 
 
Aircraft ground speed (“GS”) and true airspeed (“KTAS”), both in knots, and direction of flight, either 
south-bound (“S”) or north-bound (“N”), are also provided. Note that for SEL, higher levels tend to 
correlate with flights into the wind, where vehicle ground speeds were lower. Prevailing winds during 
testing were from the south. The ground speed values are taken from the Volpe START system – this is a 
GPS-based measurement of the speed of the vehicle over the ground derived from the sequential 
position information and the time period between each position measurement. The KTAS data values 
are derived from the vectors of the ground speed and the wind speed as recorded by the Volpe 
meteorological station at the measurement site. 

D.2.1.3 Additional SEL data and wind table  

The third table in the set contains additional SEL information not shown in the prior table due to space 
considerations. As before, the first two columns show the pass ID and the Flight Director’s logged time 
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for the pass. The microphone data columns provide event starting and ending times from which the 
duration in the primary SEL table was obtained. Also provided is  an estimate of the ambient noise level 
at the start of each event; the value is based on a five second average of the one second LEQ levels at 
the start of the SEL testing period. Ambient levels reported in these tables each represent an average of 
the LEQ levels from 30 to 25 seconds prior to the LAMax of the event. 
 
The wind data in the right-most three columns shows the average wind as measured at the 
meteorological station at the site. The average is calculated from the ten seconds around the LAMax 
time. The average crosswind (“Avg X-wind (kts)” in the table) is calculated from the dot product of the 
vectors of the vehicle and wind velocity vectors. The “wind OK?” criterion is met if the average wind 
speed was less than ten knots and the average cross wind speed was less than 5 knots during the pass. 

D.2.1.4 Statistical data table  

This table provides a statistical summary for each series of passes. As before, each microphone has its 
own set of data. The metrics for which the statistics are compiled are the LAMax (as measured), the 
LAMax normalized to a distance of 400 feet, and the SEL.  The data for each of the metrics include the 
mean and standard deviation for the passes, and the upper and lower 90% confidence intervals.  

D.2.2 Semi-static operations  

The semi-static operations are the take-off, landing, and infrastructure inspection operations. As with 
the dynamic operations, there are four data tables associated with each pass series. The first data table 
provides data for the LAMax metric and is identical in structure and format to the dynamic LAMax table. 
The next two tables provide detailed information about the distance and position of the vehicle at the 
time of the LAMax level.  The fourth table provides statistical data for the passes. The major difference 
between the presentations for the dynamic and semi-static data sets is that the Dynamic data contains 
SEL information, the semi-static operations do not – the semi-static operations have no meaningful SEL 
data because the static part of the operation is of undetermined time. Tables for semi-static operations 
do provide additional information on aircraft position and distance to help identify vehicle location at 
the time of LAMax. 

D.2.2.1 LAMax table  

The tables for Maximum A-weighted Level (LAMax) present the data for each pass. The semi-static 
LAMax data presentation is identical to the dynamic LAMax data presentation, with the exception that 
distances for the semi-static operations are normalized to a reference distance of 100 feet. This shorter 
distance is assumed to be more appropriate for operations which are likely to occur in close proximity to 
people – so, for example, a package delivery operation with landing and takeoff components is better 
represented at a 100 foot distance rather than the 400 foot distance used for dynamic operations. 

D.2.2.2 Distance and wind table  
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The Distance and Wind tables use a format generally similar to the LAMax tables. The pass ID is again 
the left-most column.  The three microphone data set occupy the middle of the table, and wind data can 
be found in the right-most three columns, as discussed below. 
 
The microphone data sets are comprised of four columns each. The first column repeats the LAMax time 
from the LAMax table. The second column repeats the distance from the vehicle to the microphone at 
the time of LAMax. Additional information columns include the time when the vehicle was at the closest 
point of approach (CPA) to the particular microphone and the slant distance of that CPA. This facilitates 
comparisons of between distance at the time of LAMax and CPA: Large differences indicate the noisiest 
configuration does not occur at the closest point of approach to the microphone.  
 
The wind data in the right-most three columns are the same as those in the SEL additional data table in 
dynamic operations. 

D.2.2.3 LAMax position data table  

The third table in the semi-static operation set contains additional position data. For each pass, in 
addition to the LAMax time and distance information repeated from the prior tables, the three 
dimensional position of the vehicle at the LAMax time is given for each microphone. Note that the X, Y, 
and Z positions given in the table are in the local coordinate system used at CNO where the X axis is 
aligned with North, the Y axis is aligned with West, and Z increases with vertical height. For this 
measurement campaign, the local coordinate system used the centerline ground plane microphone as 
the coordinate origin.  

D.2.2.4 Statistical data table  

This table contains a statistical summary for each series of passes. As before, each microphone has its 
own set of data. The metrics for which the statistics are compiled are the LAMax (as measured) and the 
LAMax normalized to a distance of 100 feet.  The data for each of the metrics include the mean and 
standard deviation for the passes, and the upper and lower 90% confidence intervals. 

D.2.3 Hover operations  

Each hover data table contains a record (i.e. a row) for each nominal 30-second interval with the vehicle 
heading oriented toward a cardinal compass direction during the particular series. Data columns include 
the starting time when the vehicle was stable - pointed in a particular direction, and an ending time 
immediately before the vehicle began yawing to the next compass direction. The difference between 
these two times – used as the averaging period – is used to determine the LEQ of the event from the 
measured half-second LEQ values. These event LEQ values and the LEQ normalized to 100 feet are also 
presented in the tables.  The normalized LEQ are calculated based on the position of the vehicle at each 
half second during the averaging period – the calculation is not based on the average vehicle position 
during the averaging period.



             CNO IPP Noise Measurements    91 

   
 
TYPHOON 
Slow LFO (1st series) 
 
Table 48, Typhoon slow overflight, Maximum A-weighted Levels, first series 

Typhoon SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

110 15:02:11.0 15:02:15.5 58.6 50.38 155.2 15:02:15.0 55.1 46.65 151.3 15:02:15.5 58.2 50.16 158.5 

120 15:03:29.0 15:03:29.5 57.9 50.17 164.3 15:03:30.5 55 46.59 152 15:03:30.5 57.6 49.67 160.5 

130 15:05:00.0 15:05:06.5 59.5 51.03 150.9 15:05:06.0 56.2 47.71 150.4 15:05:07.5 59.2 50.96 155 

140 15:06:20.0 15:06:17.0 55.9 47.47 151.6 15:06:20.0 53.4 44.79 148.4 15:06:18.5 57 48.5 150.3 

150 15:08:20.0 15:08:32.0 59.3 50.91 152.2 15:08:31.5 55.8 47.2 148.6 15:08:32.5 59.1 50.98 157.1 

 

Table 49, Typhoon slow overflight, A-weighted Sound Exposure Levels, first series 
Typhoon SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE   

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

110 15:02:11.0 32.5 70.3 Yes 50 68.2 No 34.5 70.1 Yes 9.3 12.2 S 

120 15:03:29.0 15 66.7 Yes 50 66.9 No 15.5 66.6 Yes 16.3 10.7 N 

130 15:05:00.0 25 70.2 Yes 50 68.3 No 26 69.9 Yes 10.7 17.8 S 

140 15:06:20.0 22.5 66.2 Yes 50 65.9 No 19 66.9 Yes 13.3 10.3 N 

150 15:08:20.0 29.5 70.1 Yes 50 68.1 No 29.5 69.9 Yes 9.1 13.9 S 
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TYPHOON 
Slow LFO (1st series) 
 

Table 50, Typhoon slow overflight, additional Sound Exposure Level and wind data, first series 
Typhoon SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

110 15:02:11.0 15:01:59.5 15:02:32.0 40.6 15:01:50.0 15:02:40.0 46.9 15:01:58.5 15:02:33.0 40.8 3.7 1.7 Yes 

120 15:03:29.0 15:03:25.0 15:03:40.0 35.8 15:03:05.5 15:03:55.5 48 15:03:24.5 15:03:40.0 37.1 6.1 0.4 Yes 

130 15:05:00.0 15:04:55.0 15:05:20.0 36.2 15:04:42.5 15:05:32.5 46.9 15:04:55.0 15:05:21.0 37.8 7.2 2.2 Yes 

140 15:06:20.0 15:06:07.5 15:06:30.0 36.2 15:05:55.0 15:06:45.0 46.4 15:06:09.5 15:06:28.5 35.9 4.3 2.4 Yes 

150 15:08:20.0 15:08:16.5 15:08:46.0 42.3 15:08:06.5 15:08:56.5 47.1 15:08:15.5 15:08:45.0 42.7 5.2 1.5 Yes 

 

 

Table 51, Typhoon slow overflight, statistical data, first series 
Typhoon      

SLO 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 58.2 50 68.7 55.1 46.6 67.5 58.2 50.1 68.7 

Stand. Dev. 1.5 1.5 2.1 1.1 1.1 1.1 0.9 1 1.8 

90% CI 1.4 1.4 2 1 1.1 1 0.9 1 1.7 

CI Low 56.9 48.6 66.7 54.1 45.5 66.5 57.3 49.1 67 

CI High 59.6 51.4 70.7 56.1 47.6 68.5 59.1 51 70.4 
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TYPHOON 
Fast LFO series 
 
Table 52, Typhoon fast overflight, Maximum A-weighted Levels 

Typhoon FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

210 15:10:10.0 15:10:13.0 58.0 49.2 145.3 15:10:13.0 55.1 46.12 142.2 15:10:13.0 57.8 49.14 147.6 

220 15:11:10.0 15:11:10.0 59.7 50.81 143.8 15:11:09.0 55.8 46.94 144.2 15:11:10.0 59.3 50.56 146.2 

230 15:12:05.0 15:12:11.5 58.4 50.13 154.4 15:12:11.0 54.5 46 150.3 15:12:11.0 58.8 50.37 151.5 

240 15:13:00.0 15:12:59.5 59.3 50.38 143.2 15:12:59.0 55.2 46.51 147.1 15:13:00.0 59.3 50.5 145.3 

 

 

Table 53, Typhoon fast overflight, A-weighted Sound Exposure Levels 
Typhoon FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

210 15:10:10.0 11 65.1 Yes 50 65.8 No 11.5 65.1 Yes 25.1 22.7 N 

220 15:11:10.0 11.5 67.2 Yes 50 66.4 No 11.5 67 Yes 25 31 S 

230 15:12:05.0 10.5 64.9 Yes 50 65.2 No 11 65.7 Yes 24.6 19.8 N 

240 15:13:00.0 12.5 67.1 Yes 50 66 No 12 67.1 Yes 24.8 30 S 
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TYPHOON 
Fast LFO series 
 
Table 54, Typhoon fast overflight, additional Sound Exposure Level and wind data 

Typhoon FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

210 15:10:10.0 15:10:08.0 15:10:19.0 33 15:09:48.0 15:10:38.0 46.3 15:10:07.5 15:10:19.0 33.4 3.1 1.5 Yes 

220 15:11:10.0 15:11:04.5 15:11:16.0 33.4 15:10:44.0 15:11:34.0 46.9 15:11:04.5 15:11:16.0 34.2 6.5 2.2 Yes 

230 15:12:05.0 15:12:07.5 15:12:18.0 32.6 15:11:46.0 15:12:36.0 46.3 15:12:07.5 15:12:18.5 33.9 5.4 0.3 Yes 

240 15:13:00.0 15:12:54.5 15:13:07.0 35 15:12:34.5 15:13:24.5 46.1 15:12:54.5 15:13:06.5 35 5.6 0.7 Yes 

 

 

Table 55, Typhoon fast overflight, statistical data 
Typhoon      

FLO 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 58.9 50.1 66.1 55.1 46.4 65.8 58.8 50.1 66.2 

Stand. Dev. 0.8 0.7 1.3 0.5 0.4 0.5 0.7 0.7 1 

90% CI 0.9 0.8 1.5 0.6 0.5 0.6 0.8 0.8 1.1 

CI Low 57.9 49.3 64.6 54.5 45.9 65.2 58 49.4 65.1 

CI High 59.8 50.9 67.5 55.8 46.9 66.4 59.6 50.9 67.4 
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TYPHOON 
Vertical takeoff series 
 
Table 56, Typhoon vertical takeoff, Maximum A-weighted Levels 

Typhoon TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

310 15:23:45.0 15:23:48.0 66.2 52.01 19.5 15:23:48.0 59.7 49.18 29.8 15:23:48.5 63 52.29 29.1 

320 15:27:18.0 15:27:18.0 67.7 55.08 23.4 15:27:18.0 60.4 50 30.2 15:27:19.0 63.2 55.19 39.8 

330 15:30:08.0 15:30:09.0 67.1 53.83 21.7 15:30:10.0 59.3 50.42 36 15:30:10.0 63 54.33 36.9 

340 15:32:47.0 15:32:49.5 68.8 55.52 21.7 15:32:49.5 60.6 49.94 29.3 15:32:49.5 64.8 54.18 29.5 

 

 

 

Table 57, Typhoon vertical takeoff, distance and wind data 
Typhoon 

TAK 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

310 15:23:48.0 19.5 15:23:48.0 19.5 15:23:48.0 29.8 15:23:48.0 29.8 15:23:48.5 29.1 15:23:48.0 28.2 6 1.1 Yes 

320 15:27:18.0 23.4 15:27:18.0 23.4 15:27:18.0 30.2 15:27:18.0 30.2 15:27:19.0 39.8 15:27:18.0 30.7 5.3 0.5 Yes 

330 15:30:09.0 21.7 15:30:08.0 19.3 15:30:10.0 36 15:30:08.0 29.9 15:30:10.0 36.9 15:30:08.0 28.4 4.8 0.3 Yes 

340 15:32:49.5 21.7 15:32:47.0 15.8 15:32:49.5 29.3 15:32:47.0 26.5 15:32:49.5 29.5 15:32:47.0 25.4 8.4 1.1 Yes 
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TYPHOON 
Vertical takeoff series 
 
Table 58, Typhoon vertical takeoff Maximum A-weighted Levels position data 

Typhoon 
TAK 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

310 15:23:48.0 19.5 19.1 -2.2 3.3 15:23:48.0 29.8 19.1 -2.2 3.3 15:23:48.5 29.1 18.9 -2 9 

320 15:27:18.0 23.4 17.2 -1.7 15.8 15:27:18.0 30.2 17.2 -1.7 15.8 15:27:19.0 39.8 17.6 -2.3 29.1 

330 15:30:09.0 21.7 19.7 -2.7 8.6 15:30:10.0 36 20 -2.9 22.7 15:30:10.0 36.9 20 -2.9 22.7 

340 15:32:49.5 21.7 17.3 -1.7 13 15:32:49.5 29.3 17.3 -1.7 13 15:32:49.5 29.5 17.3 -1.7 13 

 

 

Table 59, Typhoon vertical takeoff, statistical data 
Typhoon      

TAK 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 67.4 54.1 60 49.9 63.5 54 

Stand. Dev. 1.1 1.6 0.6 0.5 0.9 1.2 

90% CI 1.3 1.8 0.7 0.6 1 1.4 

CI Low 66.2 52.3 59.3 49.3 62.5 52.6 

CI High 68.7 56 60.7 50.5 64.5 55.4 
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TYPHOON 
Vertical landing series 
 
Table 60, Typhoon vertical landing, Maximum A-weighted Levels 

Typhoon LND Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

311 15:26:10.0 15:26:32.0 72.5 58.87 20.8 15:26:28.0 64.2 55.54 36.9 15:26:28.0 69.5 60.71 36.4 

321 15:28:40.0 15:29:00.5 72.7 62.18 29.8 15:28:59.5 66.4 57.97 37.9 15:28:59.5 70.3 62.28 39.7 

331 15:31:40.0 15:32:03.0 74.1 62.24 25.5 15:32:01.5 66.3 57.23 35.2 15:32:02.5 70.8 61.53 34.4 

341 15:34:15.0 15:34:41.0 71.4 61.03 30.3 15:34:38.0 65.2 58.26 45 15:34:37.0 69.8 64.16 52.3 

 

 

Table 61, Typhoon vertical landing, distance and wind data 
Typhoon 

LND 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

311 15:26:32.0 20.8 15:26:36.5 15.9 15:26:28.0 36.9 15:26:35.5 26.3 15:26:28.0 36.4 15:26:36.5 25.3 4.7 1.9 Yes 

321 15:29:00.5 29.8 15:29:11.0 19.2 15:28:59.5 37.9 15:29:10.0 29.8 15:28:59.5 39.7 15:29:19.5 28.4 4.3 0.1 Yes 

331 15:32:03.0 25.5 15:32:11.0 15.3 15:32:01.5 35.2 15:32:08.5 25.8 15:32:02.5 34.4 15:32:11.0 25.1 6.1 0.3 Yes 

341 15:34:41.0 30.3 15:34:50.0 22.3 15:34:38.0 45 15:34:46.0 32.7 15:34:37.0 52.3 15:34:50.0 29.5 6.1 0.5 Yes 
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TYPHOON 
Vertical landing series 
 

Table 62, Typhoon vertical landing, Maximum A-weighted Levels position data 
Typhoon 

LND 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

311 15:26:32.0 20.8 16.3 -2.1 12.8 15:26:28.0 36.9 22.7 -2.5 19.7 15:26:28.0 36.4 22.7 -2.5 19.7 

321 15:29:00.5 29.8 19.4 -3.6 22.3 15:28:59.5 37.9 19.5 -3.8 26.6 15:28:59.5 39.7 19.5 -3.8 26.6 

331 15:32:03.0 25.5 15.5 -2.4 20.1 15:32:01.5 35.2 16.4 -2.8 26.4 15:32:02.5 34.4 15.6 -2.5 22.3 

341 15:34:41.0 30.3 22.5 -2.4 20.1 15:34:38.0 45 22.2 -2.6 34.7 15:34:37.0 52.3 22.1 -2.3 42.8 

 

 

Table 63, Typhoon vertical landing, statistical data 
Typhoon      

LND 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 72.7 61.1 65.5 57.3 70.1 62.2 

Stand. Dev. 1.1 1.6 1 1.2 0.6 1.5 

90% CI 1.3 1.8 1.2 1.4 0.7 1.7 

CI Low 71.4 59.2 64.3 55.8 69.4 60.4 

CI High 74 62.9 66.7 58.7 70.8 63.9 
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TYPHOON 
“Infrastructure” series 
 

Table 64, Typhoon infrastructure, Maximum A-weighted Levels 
Typhoon INF Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

410 15:54:20.0 15:54:07.5 62.7 62.05 92.8 15:54:07.0 59.5 58.51 89.3 15:54:08.5 63.3 62.59 92.2 

420 15:56:20.0 15:55:55.0 62.8 62.27 94.1 15:55:55.0 59 58.1 90.1 15:55:55.0 62.4 62.19 97.6 

430 15:58:20.0 15:58:00.0 63.9 63.16 91.8 15:57:59.5 60.2 59.05 87.6 15:58:00.0 63.5 63.09 95.4 

 

 

 

Table 65, Typhoon infrastructure, distance and wind data 
Typhoon 

INF 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

410 15:54:07.5 92.8 15:54:20.0 93.2 15:54:07.0 89.3 15:54:20.0 89.9 15:54:08.5 92.2 15:54:20.0 92.6 4.4 0.8 Yes 

420 15:55:55.0 94.1 15:56:20.0 94.7 15:55:55.0 90.1 15:56:20.0 90.8 15:55:55.0 97.6 15:56:20.0 97.9 4.3 0.3 Yes 

430 15:58:00.0 91.8 15:58:20.0 91.5 15:57:59.5 87.6 15:58:20.0 87.2 15:58:00.0 95.4 15:58:20.0 94.8 3.6 0.2 Yes 
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TYPHOON 
“Infrastructure” series 
 

Table 66, Typhoon Infrastructure, Maximum A-weighted Levels position data 
Typhoon 

INF 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

410 15:54:07.5 92.8 0.1 13.1 91.9 15:54:07.0 89.3 -0.1 13 91.9 15:54:08.5 92.2 0.4 13 92 

420 15:55:55.0 94.1 -5.9 -6.7 93.6 15:55:55.0 90.1 -5.9 -6.7 93.6 15:55:55.0 97.6 -5.9 -6.7 93.6 

430 15:58:00.0 91.8 -8.4 -6.2 91.2 15:57:59.5 87.6 -8.6 -6.5 91.2 15:58:00.0 95.4 -8.4 -6.2 91.2 

 

 

 

Table 67, Typhoon infrastructure, statistical data 
Typhoon      

INF 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 63.1 62.5 59.6 58.6 63.1 62.6 

Stand. Dev. 0.7 0.6 0.6 0.5 0.6 0.5 

90% CI 1.1 1 1 0.8 1 0.8 

CI Low 62 61.5 58.6 57.8 62.1 61.9 

CI High 64.3 63.5 60.6 59.4 64.1 63.4 
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TYPHOON 
Slow LFO (2nd series) 
 
Table 68, Typhoon slow overflight, Maximum A-weighted Levels, second series 

Typhoon SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

160 16:36:00.0 16:36:02.0 58.2 50.24 160 16:36:03.5 54.5 46.16 153.1 16:36:03.5 58.1 50.01 157.6 

170 16:37:05.0 16:37:08.0 56 47.96 158.4 16:37:10.5 52.9 44.2 146.9 16:37:08.5 57.2 49.11 157.6 

 

 

Table 69, Typhoon slow overflight, A-weighted Sound Exposure Levels, second series 
Typhoon SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

160 16:36:00.0 31 69.7 Yes 47 66.7 Yes 30 69.6 Yes 10.7 16.2 S 

170 16:37:05.0 25 67 Yes 50 65.1 No 23.5 67.2 Yes 12.9 9 N 
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TYPHOON 
Slow LFO (2nd series) 
 

Table 70, Typhoon slow overflight, additional Sound Exposure Level and wind data, second series 
Typhoon SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

160 16:36:00.0 16:35:47.5 16:36:18.5 38.6 16:35:40.5 16:36:27.5 44 16:35:49.0 16:36:19.0 38.6 6 3.1 Yes 

170 16:37:05.0 16:36:57.5 16:37:22.5 37.5 16:36:45.5 16:37:35.5 44 16:36:58.0 16:37:21.5 38 4.8 2.1 Yes 

 

 

Table 71, Typhoon slow overflight, statistical data, second series 
Typhoon      

SLO 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 57.1 49.1 68.3 53.7 45.2 65.9 57.7 49.6 68.4 

Stand. Dev. 1.6 1.6 1.9 1.1 1.4 1.1 0.6 0.6 1.7 

90% CI 6.9 7.2 8.4 5.1 6.2 5.1 2.8 2.8 7.8 

CI Low 50.2 41.9 59.9 48.6 39 60.8 54.8 46.7 60.7 

CI High 64 56.3 76.7 58.8 51.4 71 60.5 52.4 76.2 
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TYPHOON 
Hovers 
 

Table 72, Typhoon hover, Equivalent Continuous Sound Level, first series 
Typhoon 

Hover Times Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Start Time End Time Averaging Time 
(sec.) LAeq LAeq Norm100 LAeq LAeq Norm100 LAeq LAeq Norm100 

50N 16:00:04.0 16:00:32.0 28 57.6 45.7 57.2 48.2 55.4 45.5 

50W 16:00:39.0 16:01:06.0 27 55.0 43.6 56.7 48.1 54.0 44.1 

50S 16:01:14.0 16:01:40.0 26 53.9 42.6 54.5 46.0 52.4 42.6 

50E 16:01:50.0 16:02:22.0 32 56.1 44.4 55.7 46.9 54.0 44.1 

 

 

Table 73, Typhoon hover, Equivalent Continuous Sound Level, second series 
Typhoon 

Hover Times Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Start Time End Time Averaging Time 
(sec.) LAeq LAeq Norm100 LAeq LAeq Norm100 LAeq LAeq Norm100 

51N 16:41:08.0 16:41:32.0 24 59.9 45.8 59.9 49.4 58.6 48.4 

51E 16:41:43.0 16:42:12.0 29 58.2 44.2 58.2 47.7 57.0 47.0 

51S 16:42:20.0 16:42:56.0 36 57.3 43.1 57.3 46.7 57.1 46.6 

51W 16:43:00.0 16:43:20.0 20 57.2 43.3 57.2 46.8 57.0 46.7 
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M200 
Slow LFO series 
 
Table 74, M200 slow overflight, Maximum A-weighted Levels 

M200 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

110 17:04:13.0 17:04:14.0 57.8 51.63 196.6 17:04:14.0 53.7 47.36 192.8 17:04:14.0 58.4 51.84 188 

120 17:06:05.0 17:06:12.5 56.8 50.16 186.2 17:06:12.5 52.6 45.77 182.2 17:06:11.5 57.2 50.36 182 

130 17:07:30.0 17:07:32.5 61 53.88 176.2 17:07:32.0 57.1 49.78 172.2 17:07:33.0 61 53.84 175.5 

140 17:08:50.0 17:08:37.5 58.3 50.95 171.6 17:08:37.5 53.6 45.98 166.4 17:08:36.5 58.3 51.02 173 

150 17:09:54.0 17:09:55.0 60.3 52.94 171.4 17:09:55.0 56.5 48.99 168.4 17:09:56.0 59.7 52.52 174.9 

 

Table 75, M200 slow overflight, A-weighted Sound Exposure Levels 
M200 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

110 17:04:13.0 12.5 66 Yes 50 64.9 No 13 66.7 Yes 22.3 27.4 S 

120 17:06:05.0 14.5 65.3 Yes 50 64.2 No 15 66.1 Yes 18 13 N 

130 17:07:30.0 15 69.8 Yes 20 66.2 Yes 15.5 69.9 Yes 16 22 S 

140 17:08:50.0 20 67.8 Yes 50 65.5 No 21 68.2 Yes 11.8 8 N 

150 17:09:54.0 16 69.4 Yes 21 66 Yes 17.5 69.3 Yes 16.7 19.1 S 

160 17:11:03.0 14.5 67.2 Yes 41 64.4 Yes 15 67.1 Yes 15.4 12 N 
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M200 
Slow LFO series 
 

Table 76, M200 slow overflight, additional Sound Exposure Level and wind data 
M200 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

110 17:04:13.0 17:04:08.0 17:04:20.5 38.5 17:03:49.0 17:04:39.0 44.4 17:04:08.0 17:04:21.0 38.5 5.2 1.3 Yes 

120 17:06:05.0 17:06:05.5 17:06:20.0 39 17:05:47.5 17:06:37.5 44.4 17:06:05.5 17:06:20.5 39.6 5.8 1.4 Yes 

130 17:07:30.0 17:07:25.5 17:07:40.5 35.4 17:07:25.0 17:07:45.0 44 17:07:25.5 17:07:41.0 35.1 6.1 0.9 Yes 

140 17:08:50.0 17:08:28.5 17:08:48.5 38.7 17:08:12.5 17:09:02.5 45.2 17:08:28.0 17:08:49.0 39.9 4 0 Yes 

150 17:09:54.0 17:09:49.0 17:10:05.0 34.1 17:09:48.0 17:10:09.0 44.1 17:09:48.5 17:10:06.0 33.9 3.2 2.4 Yes 

160 17:11:03.0 17:10:55.0 17:11:09.5 33.3 17:10:47.5 17:11:28.5 43.5 17:10:54.5 17:11:09.5 34 3.5 1.1 Yes 

 

 

Table 77, M200 slow overflight, statistical data 
M200 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 58.8 51.8 67.6 54.7 47.5 65.2 59 51.9 67.9 

Stand. Dev. 1.6 1.4 1.8 1.8 1.6 0.8 1.3 1.2 1.5 

90% CI 1.3 1.1 1.5 1.5 1.3 0.7 1.1 1 1.2 

CI Low 57.5 50.6 66.1 53.2 46.1 64.5 57.9 50.9 66.7 

CI High 60.1 52.9 69.1 56.2 48.8 65.9 60.1 52.9 69.1 
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M200 
Fast LFO series 
 
 
Table 78, M200 fast overflight, Maximum A-weighted Levels 

M200 FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

210 17:12:05.0 17:12:07.0 58.1 50.88 174.3 17:12:07.0 54.6 47.27 172 17:12:07.0 57.9 50.84 177.5 

220 17:12:55.0 17:12:59.5 59.1 51.62 169 17:12:59.5 55.4 47.76 166 17:12:59.0 59.4 51.92 169 

230 17:13:47.0 17:13:48.0 61.2 54.08 176.2 17:13:48.0 57.2 49.94 173.4 17:13:48.0 61.4 54.26 175.8 

240 17:14:35.0 17:14:36.5 58.9 51.65 173.6 17:14:35.5 55.4 47.7 164.9 17:14:35.0 59.4 52.11 172.8 

 

Table 79, M200 fast overflight, A-weighted Sound Exposure Levels 
M200 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

210 17:12:05.0 10 65.1 Yes 33.5 63.3 Yes 10.5 65.1 Yes 30 31.8 S 

220 17:12:55.0 9 65.5 Yes 14.5 62.4 Yes 9 65.9 Yes 30.3 27.2 N 

230 17:13:47.0 8.5 67.3 Yes 10 63.8 Yes 8.5 67.6 Yes 30 36 S 

240 17:14:35.0 9.5 65.8 Yes 30 62.3 Yes 8.5 65.9 Yes 30.1 26.5 N 
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M200 
Fast LFO series 
 

Table 80, M200 fast overflight, additional Sound Exposure Level and wind data 
M200 FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

210 17:12:05.0 17:12:03.5 17:12:13.5 33.5 17:11:44.5 17:12:18.0 43.9 17:12:03.0 17:12:13.5 34.2 2.1 1.1 Yes 

220 17:12:55.0 17:12:56.0 17:13:05.0 35 17:12:52.0 17:13:06.5 44.1 17:12:55.5 17:13:04.5 37.3 3.3 0.6 Yes 

230 17:13:47.0 17:13:44.5 17:13:53.0 34 17:13:44.0 17:13:54.0 43.8 17:13:44.5 17:13:53.0 34.2 6.2 0.7 Yes 

240 17:14:35.0 17:14:32.0 17:14:41.5 35.6 17:14:31.0 17:15:01.0 43.7 17:14:32.0 17:14:40.5 36.6 3.7 0.4 Yes 

 

 

Table 81, M200 fast overflight, statistical data 
M200 FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 59.3 52.1 65.9 55.7 48.2 62.9 59.5 52.3 66.1 

Stand. Dev. 1.3 1.4 1 1.1 1.2 0.7 1.4 1.4 1 

90% CI 1.6 1.6 1.1 1.3 1.4 0.8 1.7 1.7 1.2 

CI Low 57.8 50.4 64.8 54.4 46.8 62.1 57.8 50.6 64.9 

CI High 60.9 53.7 67.1 56.9 49.6 63.8 61.2 54 67.3 
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M200 
Vertical takeoff series 
 
Table 82, M200 vertical takeoff, Maximum A-weighted Levels 

M200 TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

310 17:24:46.0 17:24:53.0 67.8 60.99 45.7 17:24:52.5 61.2 54.26 45 17:24:53.0 66.6 60.62 50.2 

320 17:27:17.0 17:27:19.0 67.6 56.84 29 17:27:21.5 60.6 54.22 48 17:27:21.5 65.3 59.32 50.2 

330 17:29:24.0 17:29:29.0 67.7 56.96 29 17:29:29.0 59.9 50.98 35.8 17:29:29.0 65.4 56.51 35.9 

340 17:31:23.0 17:31:27.0 65.2 53.43 25.8 17:31:23.5 58.3 48.1 30.9 17:31:28.0 62.4 54.21 38.9 

 

 

 

Table 83, M200 vertical takeoff, distance and wind data 
M200 
TAK 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

310 17:24:53.0 45.7 17:24:46.0 19.9 17:24:52.5 45 17:24:46.0 30.5 17:24:53.0 50.2 17:24:46.5 28.9 7.6 0.2 Yes 

320 17:27:19.0 29 17:27:17.0 22.6 17:27:21.5 48 17:27:17.0 32.3 17:27:21.5 50.2 17:27:17.0 31.7 7.6 0.9 Yes 

330 17:29:29.0 29 17:29:24.0 21.4 17:29:29.0 35.8 17:29:24.0 32 17:29:29.0 35.9 17:29:24.0 30.4 5 0.3 Yes 

340 17:31:27.0 25.8 17:31:23.5 20.3 17:31:23.5 30.9 17:31:23.5 30.9 17:31:28.0 38.9 17:31:23.0 29.9 4.7 0.3 Yes 
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M200 
Vertical takeoff series 
 

Table 84, M200 Vertical takeoff, Maximum A-weighted Levels position data 
M200 
TAK 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

310 17:24:53.0 45.7 20.2 -3 40.8 17:24:52.5 45 20.2 -3 36.6 17:24:53.0 50.2 20.2 -3 40.8 

320 17:27:19.0 29 21.4 -4.4 19 17:27:21.5 48 21.1 -4.2 39.7 17:27:21.5 50.2 21.1 -4.2 39.7 

330 17:29:29.0 29 21.7 -3.3 19 17:29:29.0 35.8 21.7 -3.3 19 17:29:29.0 35.9 21.7 -3.3 19 

340 17:31:27.0 25.8 20.4 -5 15 17:31:23.5 30.9 19.9 -4 1.3 17:31:28.0 38.9 20.3 -5 23.7 

 

 

 

Table 85, M200 vertical takeoff, statistical data 
M200 TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 67.1 57.1 60 51.9 64.9 57.7 

Stand. Dev. 1.3 3.1 1.3 3 1.8 2.9 

90% CI 1.5 3.6 1.5 3.5 2.1 3.4 

CI Low 65.6 53.4 58.5 48.4 62.8 54.3 

CI High 68.5 60.7 61.5 55.4 67 61 
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M200 
Vertical landing series 
 

Table 86, M200 vertical landing, Maximum A-weighted Levels 
M200 LND Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

311 17:26:45.0 17:26:38.5 75 63.77 27.4 17:26:36.5 67 59.7 43.2 17:26:38.5 72.4 63.25 34.9 

321 17:29:00.0 17:28:56.5 74.4 64.85 33.3 17:28:56.0 66.8 58.95 40.5 17:28:55.5 71.8 64.71 44.2 

331 17:30:30.0 17:30:47.5 75.2 67.41 40.8 17:30:47.5 68.4 61.32 44.3 17:30:47.5 73.5 66.8 46.2 

341 17:32:49.0 17:32:44.0 73.6 63.58 31.6 17:32:44.0 66 57.25 36.5 17:32:44.0 70.1 61.92 39 

 

 

 

Table 87, M200 vertical landing, distance and wind data 
M200 
LND 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

311 17:26:38.5 27.4 17:27:00.0 19.7 17:26:36.5 43.2 17:27:00.0 30.2 17:26:38.5 34.9 17:27:09.0 29.2 8 0.4 Yes 

321 17:28:56.5 33.3 17:29:18.5 21.4 17:28:56.0 40.5 17:29:18.5 32 17:28:55.5 44.2 17:29:24.0 30.4 6.4 0.1 Yes 

331 17:30:47.5 40.8 17:31:17.0 20.3 17:30:47.5 44.3 17:31:17.0 30.9 17:30:47.5 46.2 17:30:54.0 29.9 5.8 0.7 Yes 

341 17:32:44.0 31.6 17:32:49.5 19.8 17:32:44.0 36.5 17:32:49.0 30.3 17:32:44.0 39 17:32:49.5 30.8 4.5 0.1 Yes 
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M200 
Vertical landing series 
 

Table 88, M200 vertical landing, Maximum A-weighted Levels position data 
M200 
LND 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

311 17:26:38.5 27.4 20.4 -3.6 18 17:26:36.5 43.2 19.9 -3.6 34.3 17:26:38.5 34.9 20.4 -3.6 18 

321 17:28:56.5 33.3 21.5 -4.1 25.1 17:28:56.0 40.5 21.4 -4.1 28.4 17:28:55.5 44.2 21.4 -4 31.7 

331 17:30:47.5 40.8 20.8 -4 34.8 17:30:47.5 44.3 20.8 -4 34.8 17:30:47.5 46.2 20.8 -4 34.8 

341 17:32:44.0 31.6 18.9 -5.1 24.8 17:32:44.0 36.5 18.9 -5.1 24.8 17:32:44.0 39 18.9 -5.1 24.8 

 

 

Table 89, M200 vertical landing, statistical data 
M200 LND Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 74.5 64.9 67.1 59.3 72 64.2 

Stand. Dev. 0.7 1.8 1 1.7 1.4 2.1 

90% CI 0.8 2.1 1.2 2 1.7 2.5 

CI Low 73.7 62.8 65.9 57.3 70.3 61.7 

CI High 75.4 67 68.2 61.3 73.6 66.6 
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M200 
“Infrastructure” series 
 

Table 90, M200 infrastructure, Maximum A-weighted Levels 
M200 INF Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

410 17:59:30.0 18:00:12.5 65.8 66.66 110.4 18:00:07.0 62.8 63.7 110.9 18:00:07.0 65.7 66.85 114.2 

420 18:02:00.0 18:02:39.0 65.7 66.59 110.8 18:02:38.5 61.4 62.18 109.3 18:02:38.5 65.4 66.36 111.7 

430 18:03:30.0 18:03:58.0 66.7 65.43 86.4 18:03:58.0 61.5 60.14 85.5 18:03:58.0 66.4 65.22 87.3 

 

 

 

Table 91, M200 infrastructure, distance and wind data 
M200 

INF 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

410 18:00:12.5 110.4 18:00:20.0 107.8 18:00:07.0 110.9 18:00:20.0 106.3 18:00:07.0 114.2 18:00:20.0 109.5 6 0.2 Yes 

420 18:02:39.0 110.8 18:02:31.0 89 18:02:38.5 109.3 18:02:31.0 88.8 18:02:38.5 111.7 18:02:31.0 90.9 5.4 0.5 Yes 

430 18:03:58.0 86.4 18:03:59.5 86.3 18:03:58.0 85.5 18:03:59.5 85.4 18:03:58.0 87.3 18:03:59.5 87.2 3.7 0.1 Yes 
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M200 
“Infrastructure” series 
 

Table 92, M200 Infrastructure, Maximum A-weighted Levels position data 
M200 

INF 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

410 18:00:12.5 110.4 15.3 -0.6 109.3 18:00:07.0 110.9 18 -1.2 111.1 18:00:07.0 114.2 18 -1.2 111.1 

420 18:02:39.0 110.8 28.2 -1.4 107.1 18:02:38.5 109.3 25.9 -1 107.1 18:02:38.5 111.7 25.9 -1 107.1 

430 18:03:58.0 86.4 19 4.3 84.2 18:03:58.0 85.5 19 4.3 84.2 18:03:58.0 87.3 19 4.3 84.2 

 

 

Table 93, M200 infrastructure, statistical data 
M200 INF Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 66.1 66.2 61.9 62 65.8 66.1 

Stand. Dev. 0.6 0.7 0.8 1.8 0.5 0.8 

90% CI 0.9 1.2 1.3 3 0.9 1.4 

CI Low 65.1 65.1 60.6 59 65 64.7 

CI High 67 67.4 63.2 65 66.7 67.6 
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M200 
Hovers 
 

Table 94, M200 hover, Equivalent Continuous Sound Level, first series 
Typhoon 

Hover Times Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Start Time End Time Averaging Time 
(sec.) LAeq LAeq Norm100 LAeq LAeq Norm100 LAeq LAeq Norm100 

50N 17:37:48.0 17:38:16.0 28 65.7 52.1 57.5 47.2 60.0 50.0 

50E 17:38:25.0 17:38:56.0 31 68.2 54.5 59.4 49.0 60.5 50.4 

50S 17:39:02.0 17:39:30.0 28 67.4 53.9 59.2 49.0 61.0 51.0 

50W 17:39:37.0 17:40:07.0 30 68.4 54.8 59.6 49.2 61.6 51.5 

 

 

Table 95, M200 hover, Equivalent Continuous Sound Level, second series 
Typhoon 

Hover Times Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Start Time End Time Averaging Time 
(sec.) LAeq LAeq Norm100 LAeq LAeq Norm100 LAeq LAeq Norm100 

51N 17:42:50.0 17:43:21.0 31 66.7 53.2 58.3 48.0 61.0 51.0 

51E 17:43:33.0 17:44:01.0 28 68.5 54.9 59.7 49.3 60.9 50.8 

51S 17:44:08.0 17:44:40.0 32 67.7 54.1 59.2 48.9 61.1 51.1 

51W 17:44:48.0 17:45:17.0 29 68.7 55.2 59.7 49.4 61.6 51.6 
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GD28X 
Slow LFO series 
 
Table 96, GD28X slow overflight, Maximum A-weighted Levels 

GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

110 15:32:25.0 15:32:25.0 71.6 63.4 155.6 15:32:24.0 67.7 58.98 146.5 15:32:23.5 71.1 62.85 154.6 

120 15:33:30.0 15:33:33.5 69.1 61 157.5 15:33:35.0 65.3 57.89 170.4 15:33:34.5 69.7 61.9 162.9 

130 15:34:34.0 15:34:32.0 71.3 63.08 155.2 15:34:35.0 67.4 58.55 144.4 15:34:33.0 71.8 63.39 152 

140 15:35:25.0 15:35:33.5 68.6 60.49 157.3 15:35:35.0 63.9 56.15 164 15:35:33.0 69.2 60.98 155.3 

 

 

Table 97, GD28X slow overflight, A-weighted Sound Exposure Levels 
GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

110 15:32:25.0 22 81.3 Yes 22 77.7 Yes 21.5 81.1 Yes 15.7 24.1 S 

120 15:33:30.0 14 77.8 Yes 15 74.1 Yes 14 78.4 Yes 19.9 10.2 N 

130 15:34:34.0 20.5 81.2 Yes 20.5 77.5 Yes 20 81.4 Yes 13.4 21.9 S 

140 15:35:25.0 15.5 77.3 Yes 17 73.1 Yes 15 78.2 Yes 18.7 12.8 N 
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GD28X 
Slow LFO series 
 

Table 98, GD28X slow overflight, Sound Exposure Level and wind data 
GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

110 15:32:25.0 15:32:14.5 15:32:36.5 47.9 15:32:17.0 15:32:39.0 47.5 15:32:15.0 15:32:36.5 46.5 8.7 2.7 Yes 

120 15:33:30.0 15:33:25.5 15:33:39.5 42.3 15:33:26.5 15:33:41.5 47.2 15:33:26.5 15:33:40.5 44 10.0 3.1 No 

130 15:34:34.0 15:34:24.0 15:34:44.5 45.9 15:34:26.5 15:34:47.0 48.1 15:34:25.5 15:34:45.5 44.9 9.1 5.8 No 

140 15:35:25.0 15:35:25.5 15:35:41.0 47.0 15:35:25.5 15:35:42.5 48.2 15:35:26.5 15:35:41.5 48.1 7.4 4.5 Yes 

 

 

Table 99, GD28X slow overflight, statistical data 
GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 70.2 62 79.4 66.1 57.9 75.6 70.4 62.3 79.8 

Stand. Dev. 1.5 1.5 2.2 1.8 1.2 2.3 1.2 1.1 1.7 

90% CI 1.8 1.7 2.5 2.1 1.5 2.7 1.4 1.2 2.0 

CI Low 68.4 60.3 76.9 64 56.4 72.9 69 61 77.7 

CI High 71.9 63.7 82 68.2 59.4 78.4 71.9 63.5 81.8 
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GD28X 
Fast LFO series 
 
Table 100, GD28X fast overflight, Maximum A-weighted Levels 

GD28X FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

210 15:36:45.0 15:36:44.0 74.6 66.2 152.1 15:36:45.5 70.3 61.7 148.6 15:36:45.0 74.9 66.27 148 

220 15:37:15.0 15:37:21.0 69.1 60.92 156 15:37:23.0 65.3 57.37 160.6 15:37:22.5 69.9 61.58 153.6 

230 15:38:00.0 15:37:59.0 74.6 66.08 149.9 15:38:00.0 70.4 62.18 155.2 15:38:00.0 74.8 67.01 163.1 

240 15:38:55.0 15:38:38.0 71.1 62.6 150.4 15:38:39.0 66.7 58.21 150.5 15:38:39.5 69.5 61.38 157.1 

 

Table 101, GD28X fast overflight, A-weighted Sound Exposure Levels 
GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

210 15:36:45.0 9.5 81.1 Yes 10.5 77.3 Yes 10 81.6 Yes 25.8 34.9 S 

220 15:37:15.0 9.5 75.9 No 10.5 72.2 No 9 76.4 Yes 26.9 17.8 N 

230 15:38:00.0 11.5 81.8 Yes 13 78.1 Yes 12 81.9 Yes 25.3 33.9 S 

240 15:38:55.0 8.5 77.1 Yes 9 73.0 Yes 8.5 76.2 Yes 26.8 18.5 N 

 

  



              CNO IPP Noise Measurements    118 

GD28X 
Fast LFO series 
 

Table 102, GD28X fast overflight, additional Sound Exposure Level and wind data 
GD28X FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

210 15:36:45.0 15:36:41.5 15:36:51.0 45.1 15:36:42.5 15:36:53.0 47.7 15:36:42.0 15:36:52.0 45.5 9.3 1.3 Yes 

220 15:37:15.0 15:37:17.0 15:37:26.5 60.6 15:37:18.0 15:37:28.5 57.5 15:37:18.5 15:37:27.5 59.8 9.3 0.4 Yes 

230 15:38:00.0 15:37:54.5 15:38:06.0 50.5 15:37:55.5 15:38:08.5 49.6 15:37:54.5 15:38:06.5 50.3 8.6 0.6 Yes 

240 15:38:55.0 15:38:34.5 15:38:43.0 54.5 15:38:35.5 15:38:44.5 52.7 15:38:35.5 15:38:44.0 52.3 10.2 2.1 No 

 

 

Table 103, GD28X fast overflight, statistical data 
GD28X FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 72.3 64 79 68.2 59.9 75.2 72.3 64.1 79 

Stand. Dev. 2.7 2.6 2.9 2.6 2.4 3 3 3 3.2 

90% CI 3.2 3.1 3.4 3 2.9 3.5 3.5 3.5 3.7 

CI Low 69.1 60.9 75.5 65.1 57 71.6 68.8 60.5 75.3 

CI High 75.6 67 82.4 71.2 62.7 78.7 75.8 67.6 82.7 
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GD28X 
Vertical takeoff series 
 
Table 104, GD28X vertical takeoff, Maximum A-weighted Levels 

GD28X TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

310 15:52:12.0 15:52:18.0 77.6 70.37 43.5 15:52:21.0 71.2 67.47 65.1 15:52:18.5 77.7 71.04 46.5 

320 15:55:03.0 15:55:06.5 82.1 68.5 20.9 15:55:09.5 74.4 67.48 45.1 15:55:08.0 81.8 71.68 31.2 

330 15:58:36.0 15:58:40.5 81.5 71.68 32.3 15:58:43.0 74.6 69.09 53 15:58:41.0 83.5 73.87 33 

340 16:01:40.0 16:01:47.0 79.7 69.93 32.5 16:01:49.0 72.6 66.61 50.2 16:01:47.5 79.8 71.59 38.9 

350 16:04:37.0 16:04:39.5 81.1 68.22 22.7 16:04:42.5 73.4 66.99 47.8 16:04:41.5 79.7 71.37 38.3 

 
 
Table 105, GD28X vertical takeoff, distance and wind data 

GD28X 
TAK 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

310 15:52:18.0 43.5 15:52:12.0 20.6 15:52:21.0 65.1 15:52:12.0 30.9 15:52:18.5 46.5 15:52:12.0 29.4 10.5 0.6 No 

320 15:55:06.5 20.9 15:55:03.5 13.3 15:55:09.5 45.1 15:55:03.5 22.9 15:55:08.0 31.2 15:55:03.0 18.8 8 0.9 Yes 

330 15:58:40.5 32.3 15:58:36.0 17.8 15:58:43.0 53 15:58:36.0 25.9 15:58:41.0 33 15:58:36.0 15 8.4 1 Yes 

340 16:01:47.0 32.5 16:01:40.0 19.4 16:01:49.0 50.2 16:01:41.0 29.6 16:01:47.5 38.9 16:01:41.0 25.5 6.1 0.4 Yes 

350 16:04:39.5 22.7 16:04:37.0 16.1 16:04:42.5 47.8 16:04:37.0 26.4 16:04:41.5 38.3 16:04:37.5 25.6 10.9 1 No 
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GD28X 
Vertical takeoff series 
 

Table 106, GD28X vertical takeoff, Maximum A-weighted Levels position data 
GD28X 

TAK 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

310 15:52:18.0 43.5 34.4 4.8 26.2 15:52:21.0 65.1 37.8 9 47 15:52:18.5 46.5 35.2 6.1 29.2 

320 15:55:06.5 20.9 18.4 4.1 9.1 15:55:09.5 45.1 23.6 6.8 33 15:55:08.0 31.2 21.1 5.4 19.8 

330 15:58:40.5 32.3 24.2 12 17.7 15:58:43.0 53 26.7 11.1 40.6 15:58:41.0 33 25.2 11.8 21.7 

340 16:01:47.0 32.5 26.8 0.9 18.2 16:01:49.0 50.2 28.7 1.5 35.4 16:01:47.5 38.9 27.5 1.1 22.4 

350 16:04:39.5 22.7 21 0.5 8.7 16:04:42.5 47.8 27 2.7 33.7 16:04:41.5 38.3 25.4 1.9 24.2 

 

 

Table 107, GD28X vertical takeoff, statistical data 
GD28X TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 80.4 69.7 73.2 67.5 80.5 71.9 

Stand. Dev. 1.8 1.4 1.4 0.9 2.2 1.1 

90% CI 1.7 1.4 1.3 0.9 2.1 1.1 

CI Low 78.7 68.4 71.9 66.6 78.4 70.8 

CI High 82.1 71.1 74.6 68.4 82.6 73 
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GD28X 
Vertical landing series 
 

Table 108, GD28X vertical landing, Maximum A-weighted Levels 
GD28X LND Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

311 15:54:35.0 15:54:32.0 80.3 64.55 16.3 15:54:22.5 73.3 65.64 41.4 15:54:26.5 85.7 70.32 17 

321 15:57:22.0 15:56:56.5 80.2 68.21 25.1 15:56:52.5 73.2 65.6 41.7 15:57:09.5 84.4 66.09 12.1 

331 16:00:37.0 16:00:30.5 77.3 66.03 27.3 16:00:21.0 71.4 66.91 59.6 16:00:24.0 79.8 71.7 39.4 

341 16:03:45.0 16:03:35.0 81.3 70.63 29.3 16:03:33.5 73.1 64.85 38.7 16:03:36.0 80.3 70.05 30.7 

351 16:06:28.0 16:06:19.0 79.3 69.81 33.5 16:06:15.0 72.8 66.97 51.1 16:06:19.5 79.4 70.03 34 

 

Table 109, GD28X vertical landing, distance and wind data 
GD28X 

LND 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

311 15:54:32.0 16.3 15:54:35.0 13.3 15:54:22.5 41.4 15:54:35.0 22.8 15:54:26.5 17 15:54:35.0 18.8 7.6 2.6 Yes 

321 15:56:56.5 25.1 15:57:23.0 17.7 15:56:52.5 41.7 15:57:23.0 25.9 15:57:09.5 12.1 15:57:23.0 14.9 8.6 1.8 Yes 

331 16:00:30.5 27.3 16:00:37.5 19.4 16:00:21.0 59.6 16:00:37.5 29.5 16:00:24.0 39.4 16:00:37.5 25.3 9.8 4.6 Yes 

341 16:03:35.0 29.3 16:03:45.5 15.9 16:03:33.5 38.7 16:03:45.5 26.2 16:03:36.0 30.7 16:03:45.5 25.5 9.8 1 Yes 

351 16:06:19.0 33.5 16:06:29.5 16 16:06:15.0 51.1 16:06:28.0 25.7 16:06:19.5 34 16:06:28.0 21.2 9.1 0.8 Yes 
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GD28X 
Landing series 
 
Table 110, GD28X vertical landing, Maximum A-weighted Levels position data 

GD28X 
LND 

Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

311 15:54:32.0 16.3 14.5 4.6 5.8 15:54:22.5 41.4 21.5 21.7 20.7 15:54:26.5 17 15.7 16.6 9.3 

321 15:56:56.5 25.1 19.5 8.5 13.3 15:56:52.5 41.7 21.1 15 27.6 15:57:09.5 12.1 11.2 13.3 4.1 

331 16:00:30.5 27.3 24.8 3 11.2 16:00:21.0 59.6 29.5 25 41.5 16:00:24.0 39.4 29.3 24.4 27.7 

341 16:03:35.0 29.3 22 2.2 19.2 16:03:33.5 38.7 21.9 1.9 25.2 16:03:36.0 30.7 21.7 2.2 15.4 

351 16:06:19.0 33.5 25.5 4.3 21.4 16:06:15.0 51.1 26.4 5 39.2 16:06:19.5 34 25.1 4.5 19.4 

 

 

Table 111, GD28X vertical landing, statistical data 
GD28X LND Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx LASmx Norm100 LASmx LASmx Norm100 LASmx LASmx Norm100 

Mean 79.7 67.8 72.8 66 81.9 69.6 

Stand. Dev. 1.5 2.5 0.8 0.9 2.9 2.1 

90% CI 1.4 2.4 0.7 0.9 2.8 2 

CI Low 78.2 65.4 72 65.1 79.1 67.6 

CI High 81.1 70.3 73.5 66.9 84.7 71.6 
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GD28X 
“Infrastructure” series 
 

Table 112, GD28X infrastructure, Maximum A-weighted Levels 
GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm100 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm100 
Distance at 

LASmx (ft) 

410 16:21:15.0 16:21:32.0 76.9 74.66 77.3 16:21:33.0 72.9 70.04 71.9 16:21:46.5 76.9 74.97 80.1 

 

 

Table 113, GD28X infrastructure, distance and wind data 
GD28X 

TAK 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID LASmx Time 
LASmx Dist. 

(ft) CPA Time 
CPA 
(ft) 

LASmx Time LASmx Dist. 
(ft) 

CPA Time CPA (ft) LASmx Time LASmx Dist. 
(ft) 

CPA Time 
CPA 
(ft) 

Avg 
Wind 
(kts) 

Avg X-
Wind 
(kts) 

Wind 
OK? 

410 16:21:32.0 77.3 16:21:29.5 77.1 16:21:33.0 71.9 16:21:30.0 71.8 16:21:46.5 80.1 16:21:29.5 78 6.6 0.7 Yes 

 

 

Table 114, GD28X Infrastructure, Maximum A-weighted Levels position data 
GD28X 

INF 
Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID LASmx Time 
LASmx Dist. 

(ft) X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) 

X (ft) Y (ft) Z (ft) LASmx Time LASmx Dist. 
(ft) X (ft) Y (ft) Z (ft) 

410 16:21:32.0 77.3 -15.1 6.1 75.5 16:21:33.0 71.9 -14.9 6.5 75.6 16:21:46.5 80.1 -14.8 8 77.5 
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GC28X 
Hovers 
 

Table 115, GD28X hover, Equivalent Continuous Sound Level, first series 
Typhoon 

Hover Times Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Start Time End Time Averaging Time 
(sec.) LAeq LAeq Norm100 LAeq LAeq Norm100 LAeq LAeq Norm100 

50N 16:28:55.0 16:29:37.0 42 79.1 - - - 80.5 - 

50E 16:29:52.0 16:30:21.0 29 77.5 - - - 77.5 - 

50S 16:30:28.0 16:31:00.0 32 77.3 - - - 73.7 - 

50W 16:31:07.0 16:31:44.0 37 80.3 - - - 75.9 - 

 

 

Table 116, GD28X hover, Equivalent Continuous Sound Level, second series 
Typhoon 

Hover Times Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Start Time End Time Averaging Time 
(sec.) LAeq LAeq Norm100 LAeq LAeq Norm100 LAeq LAeq Norm100 

51N 16:46:42.0 16:47:00.0 18 77.2 - - - 74.6 - 

51E 16:47:10.0 16:47:35.0 25 78 - - - 77 - 

51S 16:47:42.0 16:48:12.0 30 74.7 - - - 72.9 - 

51W 16:48:23.0 16:48:53.0 30 75.8 - - - 72.7 - 

 

Tracking data during the GD28X hover operations were not available, so LAeq values at the normalized distance could not be determined. Also, the signal 
from the centerline pole microphone was lost during these events.
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D.3 Fixed-wing Vehicles 

The X-8 fixed-wing vehicle performed only dynamic operations. For this vehicle, unlike the rotary-wing 
vehicles, takeoff is a fully dynamic operation. The tables for these takeoffs, as well as for the slow and 
fast overflights, are structured and formatted in the same manner as for the dynamic operations 
discussed above for the rotary-wing vehicles. 
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X-8 
Slow LFO (1st series) 
 
Table 117, X-8 slow overflight, Maximum A-weighted Levels, first series 

X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

110 17:25:18.0 17:25:15.0 51 44.23 183.4 17:25:16.0 49.5 41.79 164.6 17:25:16.0 50.9 43.21 165 

120 17:26:30.0 17:26:32.5 52.9 46.97 202.2 17:26:34.0 50 47.88 313.4 17:26:31.5 52.9 44.71 155.9 

130 17:27:45.0 17:27:48.5 54.7 46.18 150 17:27:50.0 50.4 43.55 181.7 17:27:49.5 54.6 47.68 180.3 

140 17:29:00.0 17:29:01.5 51.8 45.73 198.8 17:29:03.0 48.9 46.62 307.8 17:28:59.5 51.3 42.91 152.2 

 

 

Table 118, X-8 slow overflight, A-weighted Sound Exposure Levels, first series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

110 17:25:18.0 28.5 61.3 Yes 50 62.9 No 25 61.3 Yes 25.3 33.5 S 

120 17:26:30.0 11 60.2 Yes 50 61.7 No 10 59.8 Yes 50.1 44.8 N 

130 17:27:45.0 16 62.5 Yes 50 63.3 No 18 62.7 Yes 25.2 33.2 S 

140 17:29:00.0 11 59.6 Yes 50 61.4 No 12.5 60 Yes 49.9 43.4 N 

 

  



              CNO IPP Noise Measurements    128 

X-8 
Slow LFO (1st series) 
 

Table 119, X-8 slow overflight, additional Sound Exposure Level and wind data, first series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

110 17:25:18.0 17:25:01.5 17:25:30.0 38.6 17:24:51.0 17:25:41.0 43.9 17:25:06.5 17:25:31.5 36.7 8.4 1 Yes 

120 17:26:30.0 17:26:26.5 17:26:37.5 36.7 17:26:09.0 17:26:59.0 44.1 17:26:28.0 17:26:38.0 37.4 5.4 0.9 Yes 

130 17:27:45.0 17:27:39.5 17:27:55.5 33.8 17:27:25.0 17:28:15.0 43.1 17:27:38.5 17:27:56.5 33.8 7.9 0.9 Yes 

140 17:29:00.0 17:28:56.0 17:29:07.0 34.6 17:28:38.5 17:29:28.5 43.1 17:28:56.5 17:29:09.0 36.3 6.9 2.5 Yes 

 

 

Table 120, X-8 slow overflight, statistical data, first series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 52.6 45.8 60.9 49.7 45 62.3 52.4 44.6 60.9 

Stand. Dev. 1.6 1.2 1.3 0.6 2.8 0.9 1.7 2.2 1.3 

90% CI 1.9 1.4 1.5 0.8 3.3 1.1 2 2.6 1.6 

CI Low 50.7 44.4 59.4 48.9 41.7 61.2 50.4 42.1 59.4 

CI High 54.5 47.1 62.4 50.5 48.2 63.4 54.4 47.2 62.5 
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X-8 
Fast LFO (1st series) 
 
Table 121, X-8 fast overflight, Maximum A-weighted Levels, first series 

GD28X FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

210 17:30:04.0 17:30:04.5 62.2 56.3 202.7 17:30:05.5 58.8 54.96 257 17:30:05.5 61.8 58.47 272.7 

220 17:31:05.0 17:31:03.5 58.8 51.84 179.5 17:31:05.0 55.4 47.97 170.1 17:31:04.5 58.2 50.08 157 

230 17:32:05.0 17:32:08.0 60.9 54.35 188.1 17:32:09.0 57.9 53.02 228 17:32:10.0 61.6 59.19 303.1 

240 17:33:05.0 17:33:05.5 59.7 52.01 165 17:33:25.0 59 68.66 1216.6 17:33:06.5 60 52.03 159.9 

 

Table 122, X-8 fast overflight, A-weighted Sound Exposure Levels, first series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

210 17:30:04.0 10.5 68.4 Yes 12.5 66 Yes 10.5 68.3 Yes 45.9 52.7 S 

220 17:31:05.0 7.5 65 Yes 13.5 63 Yes 9 64.8 Yes 63.7 58.7 N 

230 17:32:05.0 12 69.3 Yes 19 67.2 Yes 12.5 69.5 Yes 41.8 51.1 S 

240 17:33:05.0 21.5 66.4 Yes 26 65.9 Yes 8.5 66.3 Yes 56.1 51.8 N 
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X-8 
Fast LFO (1st series) 
 

Table 123, X-8 fast overflight, additional Sound Exposure Level and wind data, first series 
X-8 FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

210 17:30:04.0 17:29:58.0 17:30:08.5 34.3 17:29:58.0 17:30:10.5 43 17:29:59.0 17:30:09.5 35.5 6.9 0.8 Yes 

220 17:31:05.0 17:31:02.0 17:31:09.5 36.8 17:31:00.0 17:31:13.5 42.3 17:31:02.5 17:31:11.5 36.5 5.1 0.5 Yes 

230 17:32:05.0 17:32:01.0 17:32:13.0 37.6 17:31:58.5 17:32:17.5 43.4 17:32:02.0 17:32:14.5 35.2 9.5 0.5 Yes 

240 17:33:05.0 17:33:03.0 17:33:24.5 40.6 17:33:04.5 17:33:30.5 42.9 17:33:04.0 17:33:12.5 40.4 7.6 1.9 Yes 

 

 

Table 124, X-8 fast overflight, statistical data, first series 
X-8  FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 60.4 53.6 67.3 57.8 56.2 65.5 60.4 54.9 67.2 

Stand. Dev. 1.5 2.1 1.9 1.7 8.8 1.8 1.7 4.6 2.1 

90% CI 1.7 2.5 2.3 1.9 10.4 2.1 2 5.4 2.5 

CI Low 58.7 51.1 65 55.8 45.7 63.4 58.4 49.6 64.8 

CI High 62.1 56.1 69.6 59.7 66.6 67.6 62.4 60.3 69.7 
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X-8 
Takeoff 
 
 
Table 125, X-8 takeoff, Maximum A-weighted Levels 

GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

310 17:34:45.0 17:34:45.5 56.9 51.55 216 17:34:46.5 55.1 50.81 244 17:34:46.0 57.3 52.52 230.7 

320 17:35:33.0 17:35:37.0 59.3 52.35 179.8 17:35:38.5 57.1 52.46 234.4 17:35:38.5 59.6 55.1 238.1 

330 17:36:19.0 17:36:20.5 62.7 53.99 146.8 17:36:21.0 60.4 52.39 159 17:36:21.0 63.3 55.8 168.6 

340 17:36:58.0 17:36:59.0 62.8 52.9 128 17:37:00.0 60.4 52.68 164.6 17:36:59.5 64.2 55.48 146.6 

 

 

Table 126, X-8 takeoff, A-weighted Sound Exposure Levels 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

310 17:34:45.0 5 61.8 No 6.5 60.9 No 5.5 62.8 No 26.1 32.1 S 

320 17:35:33.0 8 65.8 Yes 9 64.1 Yes 8.5 66.3 Yes 27.3 34.8 S 

330 17:36:19.0 5.5 68.4 No 7 66.8 No 6 69.2 No 30 39.6 S 

340 17:36:58.0 6 68.4 No 7 66.7 No 6.5 69.7 No 30.8 36 S 
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X-8 
Takeoff 
 

Table 127, X-8 takeoff, additional Sound Exposure Level and wind data 
X-8 TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

310 17:34:45.0 17:34:45.0 17:34:50.0 53.9 17:34:45.0 17:34:51.5 51.2 17:34:45.0 17:34:50.5 53.2 6.1 1.2 Yes 

320 17:35:33.0 17:35:33.0 17:35:41.0 45.5 17:35:33.5 17:35:42.5 42.9 17:35:33.5 17:35:42.0 39.9 7.7 3.5 Yes 

330 17:36:19.0 17:36:19.0 17:36:24.5 56.9 17:36:19.0 17:36:26.0 53.3 17:36:19.0 17:36:25.0 55.7 10.6 3.6 No 

340 17:36:58.0 17:36:58.0 17:37:04.0 57.8 17:36:58.0 17:37:05.0 54.6 17:36:58.0 17:37:04.5 56.7 8.1 6.5 Yes 

 

 

 

Table 128, X-8 takeoff, statistical data 
X-8  TAK Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 60.4 52.7 66.1 58.2 52.1 64.6 61.1 54.7 67 

Stand. Dev. 2.9 1 3.1 2.6 0.9 2.8 3.2 1.5 3.2 

90% CI 3.4 1.2 3.6 3.1 1 3.3 3.8 1.8 3.7 

CI Low 57.1 51.5 62.5 55.2 51.1 61.3 57.3 53 63.3 

CI High 63.8 53.9 69.7 61.3 53.1 67.9 64.9 56.5 70.7 
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X-8 
Slow LFO (2nd series) 
 
 
Table 129, X-8 slow overflight, Maximum A-weighted Levels, second series 

GD28X SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

150 17:56:00.0 17:56:01.0 53.1 41.24 102.1 17:56:00.5 49.8 37.79 100.4 17:56:02.5 53.1 43.63 134.5 

160 17:57:15.0 17:57:15.5 54.1 42.3 102.8 17:57:15.0 51.4 39.56 102.3 17:57:16.5 53.9 45.2 147 

170 17:58:40.0 17:58:42.5 53.7 42.55 110.8 17:58:45.5 51.9 45.21 185.1 17:58:44.0 53.1 44.62 150.7 

180 17:59:53.0 17:59:53.0 54.2 42.26 101.1 17:59:54.5 51.4 43.68 164.5 17:59:52.5 54.2 43.47 116.2 

 

 

Table 130, X-8 slow overflight, A-weighted Sound Exposure Levels, second series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

150 17:56:00.0 15.5 62.1 Yes 50 61.9 No 15.5 62 Yes 28 33.1 S 

160 17:57:15.0 9 61.2 Yes 47 62.4 No 8.5 60.7 Yes 55 46.1 N 

170 17:58:40.0 18 63.1 Yes 50 62.9 No 17.5 62.7 Yes 25.4 33.9 S 

180 17:59:53.0 9 61 Yes 50 62.4 No 31.5 61.7 No 48.3 40.4 N 
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X-8 
Slow LFO (2nd series) 
 

Table 131, X-8 slow overflight, additional Sound Exposure Level and wind data, second series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

150 17:56:00.0 17:55:52.5 17:56:08.0 37.8 17:55:35.5 17:56:25.5 42.4 17:55:54.0 17:56:09.5 35.9 5.5 1.6 Yes 

160 17:57:15.0 17:57:11.5 17:57:20.5 34.8 17:56:53.0 17:57:40.0 42.2 17:57:12.5 17:57:21.0 35.2 9.4 2.4 Yes 

170 17:58:40.0 17:58:31.0 17:58:49.0 37.1 17:58:20.5 17:59:10.5 42.1 17:58:33.0 17:58:50.5 36.7 8.7 2.2 Yes 

180 17:59:53.0 17:59:49.0 17:59:58.0 36 17:59:30.0 18:00:20.0 42.4 17:59:27.5 17:59:59.0 48.7 9.9 6.3 Yes 

 

 

 

Table 132, X-8 slow overflight, statistical data, second series 
X-8  SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 53.8 42.1 61.8 51.1 41.6 62.4 53.6 44.2 61.7 

Stand. Dev. 0.5 0.6 0.9 0.9 3.5 0.4 0.6 0.8 0.8 

90% CI 0.6 0.7 1.1 1.1 4.1 0.5 0.7 1 1 

CI Low 53.2 41.4 60.7 50 37.5 61.9 52.9 43.3 60.8 

CI High 54.4 42.8 62.9 52.2 45.6 62.9 54.2 45.2 62.7 
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X-8 
Fast LFO (2nd series) 
 
 
Table 133, X-8 fast overflight, Maximum A-weighted Levels, second series 

GD28X FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Pass ID Log Time Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 
Time LASmx LASmx LASmx Norm400 

Distance at 
LASmx (ft) 

Time LASmx LASmx LASmx Norm400 
Distance at 

LASmx (ft) 

250 18:00:56.0 18:00:57.5 64.3 52.94 108.1 18:00:59.0 61 53.2 162.9 18:00:58.5 63.3 54.91 152.3 

260 18:02:03.0 18:02:01.5 59.7 53.31 191.6 18:02:02.5 57.3 46.52 115.7 18:02:02.0 59.7 51.54 156.3 

270 18:03:05.0 18:03:06.5 63.6 52.39 110 18:03:08.0 60 51.94 158.1 18:03:08.0 62.9 55.72 175 

280 18:04:12.0 18:04:11.5 63.2 52.47 116.2 18:04:13.0 60.6 53.21 170.9 18:04:12.5 62.4 52.54 128.5 

 

 

Table 134, X-8 fast overflight, A-weighted Sound Exposure Levels, second series 
X-8 SLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. speed & direction 

Pass ID Log Time 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

Duration 
(sec.) 

LAE 
10dBA 

OK? 
Duration 

(sec.) 
LAE 

10dBA 
OK? 

GS (kts) KTAS direction 

250 18:00:56.0 8 70.4 Yes 13 68.2 Yes 9 69.9 Yes 43 51.3 S 

260 18:02:03.0 8 65.6 Yes 12 64.3 Yes 8.5 65.9 Yes 64.5 57.4 N 

270 18:03:05.0 8 69.8 Yes 12 67 Yes 9 69.5 Yes 40.9 47.5 S 

280 18:04:12.0 6 68.1 Yes 16.5 65.9 Yes 6 67.4 Yes 68.3 58.3 N 
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X-8 
Fast LFO (2nd series) 
 

Table 135, X-8 fast overflight, additional Sound Exposure Level and wind data, second series 
X-8 FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. Avg winds & criteria 

Pass ID Log Time 
LAE Start 

Time 
LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

LAE Start 
Time 

LAE End 
Time 

Ambient 
dBA 

Avg Wind 
(kts) 

Avg X-Wind 
(kts) 

Wind OK? 

250 18:00:56.0 18:00:53.0 18:01:01.0 36.4 18:00:50.5 18:01:03.5 43.9 18:00:53.5 18:01:02.5 36.5 9.1 4.8 Yes 

260 18:02:03.0 18:01:58.5 18:02:06.5 37.9 18:01:59.0 18:02:11.0 43.4 18:02:00.0 18:02:08.5 37.6 7.1 0.1 Yes 

270 18:03:05.0 18:03:02.5 18:03:10.5 37.8 18:03:01.5 18:03:13.5 42 18:03:03.5 18:03:12.5 35.9 7.9 3.5 Yes 

280 18:04:12.0 18:04:09.0 18:04:15.0 36.6 18:04:10.0 18:04:26.5 42.9 18:04:10.0 18:04:16.0 37.1 11.1 3.3 No 

 

 

Table 136, X-8 fast overflight, statistical data, second series 
X-8  FLO Centerline Ground Mic. Centerline Pole Mic. Sideline Ground Mic. 

Metric LASmx 
LASmx 

Norm400 
LAE LASmx 

LASmx 
Norm400 

LAE LASmx 
LASmx 

Norm400 
LAE 

Mean 62.7 52.8 68.5 59.7 51.2 66.3 62.1 53.7 68.2 

Stand. Dev. 2.1 0.4 2.2 1.7 3.2 1.7 1.6 2 1.9 

90% CI 2.4 0.5 2.6 2 3.7 1.9 1.9 2.3 2.2 

CI Low 60.3 52.3 65.9 57.8 47.5 64.4 60.2 51.4 65.9 

CI High 65.1 53.3 71.1 61.7 55 68.3 64 56 70.4 
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